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What's New in Sanction

The following enhancements are included in the Sanction version 5 release. For more release
information, see the Release Notes. 

Sanction v5

Data Integrity

Sanction now provides a way to create and manage multiple backup files. This new feature
allows trial technicians to have multiple backups in case of corruption and helps prevent data
loss.

See About Backups and Backing up a case file  for more information.

Duplicating Files

Updated changes to the user interface allow users to easily detect and edit their files in their
presentation before and during a trial. This immediately alerts the user of any duplicate
imports of transcripts and exhibit files, as well as the ability to choose what to name
duplicate files being imported into your case. 

See Import Overview for more information. 

Case Editor

Sanction now provides a built in Case Editor feature that provides a simpler way to manage
data for presentations in Sanction. Users can easily make adjustments and bulk edits to the
case using the new Find and Replace feature.

See Finding and Replacing Case Items for more information. 

Transcript Manager

Sanction's updated Transcript Manager is now built-in and allows you to easily modify
elements of your transcript as you build your presentation. 

See About Transcripts, Importing Transcripts, and Synchronized Transcripts for more
information.

Synchronization between Text Files and Video Files

Sanction has updated the methods to synchronize text and video files. This new feature
allows users to easily set timestamps as well as export synchronized packages in various
standard formats. 

See Synchronizing Text and Video and Exporting Exhibits, Media Clips, Playlists, and Clip
Lists for more information. 
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Related Topics

About Sanction

Release Notes
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Using Sanction

Getting Started

Quick Start Guide

For those new to Sanction®, this topic provides a basic workflow you can use to put together
and run your first presentation. Links to the main topics that represent each step in the
workflow are provided. To try the main steps on your own, consider opening the sample case
that comes with Sanction. Or create your own test case and populate it with documents,
images, media, and transcripts of your choosing. 

Tasks listed under Other things to try, represent suggested next steps to try after you have
completed the major steps. 

Step Topics

Step 1. Create your case. Create, Open, and Pin Cases

Other things to try out in this step:

Open the sample case to practice. Sample Sanction Case

Change the default location where
cases will be saved. 

Change the Default Case Path

Create folders in your case to help keep
exhibits and media organized.

User Folders 

Step 2. Import exhibits, media, and
transcripts

Importing Exhibits

Importing Media

Importing Transcripts

Other things to try out in this step:

Configure Sanction to find media for your
case in any folder path on your computer.

Preferred Media Paths

Step 3. Prepare exhibits for
presentation.

Annotation Tools

Other things to try out in this step:

Show layers of annotations to help
reinforce your point.

Annotation Layers

Create a screen capture, which is a
new exhibit you make from an
existing exhibit. 

Screen Captures

Create a video still, which is a new
exhibit you make from a single frame
of video.

Video Stills

Rename or renumber your exhibits
individually or in batches. 

Editing Item Properties

Wizards for Renaming, Renumbering, and
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Bates Numbering

Stamp exhibits with page names,
exhibit or trial numbers, or Bates
numbers.

Exhibit Stamps

Step 4. Prepare media for presentation.
Media Clips

Playlists

Step 5. Prepare transcripts for
presentation.

Create a text clip, which is a new
exhibit you make from the text of an
exhibit.

Create media clips from a
synchronized transcript.

Creating Text Clips 

Synchronized Transcripts

Other things to try out in this step:

Search for transcript text.

Searching Transcript Text

Step 6. Create your presentation.

Creating a Presentation

Adding and Removing Items

Other things to try out in this step:

After adding items to your
presentation, you can change the
sequence in which they will be
presented. 

Prior to running a presentation,
review the options you can set for
running presentations. 

Changing Item Presentation Sequence

Setting Presentation Options

Step 7. Run your presentation.

Opening and Closing the Presentation
Window 

Controlling Item Presentation

Other things to try out in this step:

Start, pause, and stop playback, of
media, clips, and playlists. 

Media Playback

Add items to your presentation in real
time.

Using the Show Item Command

Display 2, 3, or 4 items at the same
time in the presentation window.

Displaying Multiple Item Windows

Annotate an exhibit in real time.
Annotating in Real Time

Related Topics

Customizing the Layout

Keyboard Shortcuts
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Customizing the Layout

You can adjust the layout of the main program window to accommodate how you want to
work. 

When working with exhibits, exhibit pages, and media, you can change the column width,
move columns, and sort item lists by column value.

When working with exhibits and exhibit pages, you can choose to show or hide columns that
show the number of pages, exhibit number, trial exhibit number, admit date, begin Bates
number, and end Bates number.

When working with annotation tools, you can give yourself more screen space by hiding the
exhibit details. If you decide to show exhibit details, you can position them either to the left
or to the right of the exhibit page viewer.

When working with exhibits and other items, you can further customize the workspace by
collapsing and expanding navigation panels. Collapsing the panels hides the folder list and
the navigation bars. 

Note that the layout customizations you make persist between sessions.

To change column width

1. Position your mouse over margin of the column you want to resize.

The cursor changes.

2. Drag left or right to resize the column.

 To show or hide exhibit and page list columns

1. Right-click any column header for either the exhibit list or the page list.

2. Select the columns you want to be displayed. 

Right-click exhibit list or exhitbit page list 

 To move columns
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Drag the column header left or right to its new position. 

 To sort a list by column value

1. Click the column you want to sort by. 

A small sorting icon appears at the top of the selected column.

Exhibit list sorted by Exhibit #

2. Click the column header.

The list is sorted on the values in that column.

To control the item details panel

1. Click the Exhibits navigation bar.

2. Select one of the following options, depending on what you want to do:

Option Steps

Position exhibit details to the left of the
exhibit viewing window.

In the VIEW tab, in the Layout group,
click Details View and then click Left.
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Minimize the details to the left of the exhibit
viewing window.

In the VIEW tab, in the Layout group,
click Details View and then click
Minimized.

Position exhibit details to the right of the
exhibit viewing window.

In the VIEW tab, in the Layout group,
click Details View and then click Right.

To minimize the navigation pane

Do one of the following:

Click the navigation bar minimize button.

On the VIEW tab, in the Layout group, click Navigation Pane and then click Minimized.
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To restore the navigation pane to its original size

Do one of the following:

Click the navigation bar maximize button.

On the VIEW tab, in the Layout group, click Navigation Pane and then click Normal.
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Related Topics

Keyboard Shortcuts

Navigating Sanction

Presenting on a Second Display

FILE Tab

This topic describes the functional areas of Sanction having to do with the FILE tab. You can
access many wizards from the FILE tab. You can also set the default behavior for tools and for
the presentation window, as well as set many of the properties for the case, such as paths to
media. 

Interface
element

Description

1. Program tabs These provide access to other areas of the program: HOME, VIEW, and
IMAGE TOOLS, which are described in the topics that follow.

2. Back button This button collapses the FILE tab. It is only active when a case is open.

3. Info area Import -- Add Items. Use this to import exhibits, media, transcripts,
or exhibit load files. Overview of Importing

Rename & Renumber -- Renaming and Numbering Wizards. Use this
to rename exhibits, and to generate exhibit numbers and Bates
numbers. Wizards for Renaming, Renumbering, and Bates Numbering

Exhibit Stamp -- Exhibit Stamp Wizard. Use this to apply exhibit
stamps, which may include: page name, exhibit number, trial exhibit
number, Bates number and case number.  Exhibit Stamps.

Export -- Export Files. Use this to export exhibits, media clips, and
playlists. Exporting Exhibits, Media Clips, and Playlists

Copy Video Files -- Copy video files to the case media directory.
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When you import video files, Sanction simply creates a link to the
source location of the video. If you ever want to move your case,
running the Copy Video Files wizard can help you to consolidate all
the video for your case into the case folder. Copy Video Files to the
Case Media Folder

Case Properties -- Case Directory. Shows and allows you to change
the default directory for your case file and case folder. Change the
Default Case Path

File Version. Shows the major and minor version number of your copy
of Sanction. 

Media Paths -- Case Media Paths. Use this to add, remove, or
change folder paths to media for the case. Preferred Media Paths

4. Open case
and Close case

Open

Select a recently opened case, browse to an existing case, or open a
new case. Also pin a case to the case list so you can quickly access it
later on. Create, Open, and Pin Cases

Access the sample case. Sample Sanction Case

Close

Close the currently open case.

5. Help, Options,
About, and
Activate

Help

Open product documentation. 

Access How to Video Library

Options

Set the default case folder. Change the Default Case Path

Set options for the media player. 

View the storage location for log files. annotations and for the
presentation windows. Setting Presentation Options

Set the default annotation tool.

Change font settings for the annotation text tool.

Set options for the tear out tool.

Set the resolution for PDF files.

Set options for the presentation of synchronized text.

Set numerous options for the presentation window.

About

View version information, product registration information, and the
end-user license agreement (EULA).

Activate

Start the product activation wizard.

Related Topics

Customizing the Layout

Keyboard Shortcuts

http://www.lexisnexis.com/en-us/litigation/products/tutorials.page
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HOME - Exhibits Area

You can access exhibits and related program functionality in the Exhibits area.

Interface element Description

Button groups for Exhibits These button groups provide functionality for working with
exhibits. 

Case properties panel Right-click the panel to access the case media paths and case
properties. For more information, see: Set Presentation
Options, Change the Default Case Path, and  Preferred Media
Paths.

Default exhibit folders These folders are created for you when you create a case.
They cannot be moved, renamed, or deleted. 

The Captures folder is where Sanction puts the screen
captures that you make of exhibits. For more information,
see: Screen Captures and Default Folders and Item Types.

The Text Clips folder is where Sanction puts images that you
clip from sections of transcripts. For more information, see:
Text Clips.

The Timelines folder is a place where you can store images
of timelines. 

The Video Stills folder is where Sanction puts still images
that you create from video frames. For more information,
see: Video Stills.
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A user folder In the screen capture above, MyFolder is an example of a user-
created folder.

User folders can be renamed, moved, or deleted as needed.

For more information, see: User Folders.

Navigation bars These provide access to folders for exhibits, media, transcripts,
and presentations. 

Navigation Pane minimize
button

This button minimizes the navigation pane. Use this as an
alternative to the VIEW menu, Navigation Pane selection. 

See: Customizing the Layout

Exhibit list

          and 

Exhibit page list

The exhibits contained in the selected folder. 

The pages of the selected exhibit.

Exhibit viewer Provides a view of the selected exhibit page. 

Layout controls Provide control over layout/magnification in the exhibit viewer.

When you click the Exhibits navigation bar, the button groups of the HOME menu change to
reflect options available when working with exhibits.
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Home tab when Exhibits navigation bar is selected

Shortcut keys - HOME > Exhibits Area

Group > Button Task Shortcut

New > Import
Import exhibits, media, transcripts,
exhibit load files, and clip lists.

Ctrl+I

New > New
Folder

Create a new folder. Ctrl+Shift+F3

New > Capture
Create a screen capture of the
contents of the exhibit viewer.

F7

Actions >
Rename

Rename items and folders. F2

Actions > Update
Exhibit

Add pages to an exhibit or update
existing pages. 

Ctrl+U

Actions > Edit
Edit exhibit or page properties,
such as the name, exhibit number,
or Bates number.

Ctrl+Shift+I

Actions > Move Move the selected exhibit. Ctrl+Shift+F2

Actions > Delete Delete the selected exhibit. Ctrl+D

Actions >
Rename Folder

Rename the selected folder. Ctrl+Shift+F

Actions > Move
Folder

Move the selected folder. Ctrl+Shift+M

Actions > Delete
Folder

Delete the selected folder. (Folder
must be empty.)

Ctrl+Shift+D

Add To >
Presentation

Add the selected page to the
existing presentation of your
choice. Or create a new
presentation from a selected
page.

Ctrl+Shift A

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected
item in the presentation window.

Ctrl+S

Share > Export
Export exhibits, clips, playlists, and
duration list reports. 

Ctrl+Shift+E

Share > Print Print exhibits. Ctrl+Shift+P

Search > Find
and Replace
Items

Search for items by item
properties, such as name, exhibit
number, trial number, Bates
number, or description.

Search for items by admit date or
transcript date. 

Ctrl+F
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Related Topics

Customizing the Layout

Keyboard Shortcuts

HOME - Media Area

You can access media, playlists, clips, and related program functionality in the Media area.

Interface element Description

Case properties panel Right-click the panel to access the case media paths and case
properties. For more information, see: Set Presentation Options,
Change the Default Case Path, and  Preferred Media Paths.

Media folders The Media folder and its Videos subfolder are created by default
and cannot be moved or renamed. However, you can create new
folders in the Media folder.

Playlist folder This folder holds playlists.

Navigation bars These provide access to exhibits, media, transcripts, and
presentations.

Navigation Pane minimize
button

This button minimizes the navigation pane. Use this as an
alternative to options on the VIEW tab. For more information,
see: Customizing the Layout.
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Media item list Select an item to view it in the media player.

Clip Creator Use this to create and edit media clips.

Media player With the Media player, you can play media, clips, and playlists,
and create video stills.

Clip list Provides a list of any clips created from the selected media item.
When clips are selected, the Playlist button becomes active. If no
clips have been created for the selected media item, the list is
empty.

The Media navigation bar

When you click the Media navigation bar, the button groups of the HOME menu change to
reflect options available when working with media, clips, and playlists.

HOME tab when Media navigation bar is selected

Shortcut keys - HOME > Media

Group > Button Task Shortcut
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New > Import
Import exhibits, media,
transcripts, exhibit load files, and
clip lists.

Ctrl+I

New > New
Folder

Create a new folder. Ctrl+Shift+F3

New > Video
Still

Create a video still from a frame
of video.

Ctrl+Shift+V

Actions >
Rename

Rename the selected media or
clip.

F2

Actions > Edit Edit the properties of the selected
media or clip.

Ctrl+Shift+I

Actions > Move Move the selected media item. Ctrl+Shift+F2

Actions > Delete Delete the selected media or clip. Ctrl+D

Actions >
Rename Folder

Rename the selected folder. Ctrl+Shift+F

Actions > Move
Folder

Move the selected folder. Ctrl+Shift+M

Actions > Delete
Folder

Delete the selected folder. (Folder
must be empty.)

Ctrl+Shift+D

Actions > Move
Up

Move the selected clip up in the
playlist.

Ctrl+Alt+U

Actions > Move
Down

Move the selected clip down in
the playlist.

Ctrl+Alt+U

Actions >
Remove Item

Remove the selected clip from the
playlist.

Ctrl+Alt+R

Add To >
Presentation

Add the selected media to the
existing presentation of your
choice. Or create a new
presentation from a selected
media.

Ctrl+Shift A

Add To >
Playlist

Add the selected clip to an
existing playlist. Or create a new
playlist from a selected clip.

Ctrl+Y

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected
item in the presentation window.

Ctrl+S

Share > Export Export exhibits, clips, playlists,
and duration list reports. 

Ctrl+Shift+E

Share > Print Print exhibits. Ctrl+Shift+P

Search > Find
Items

Search for items by item
properties, such as name, exhibit
number, trial number, Bates
number, or description.

Search for items by admit date or
transcript date. 

Ctrl+F
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Related Topics

Customizing the Layout

Keyboard Shortcuts

HOME - Transcripts Area

You can access transcripts, synchronized transcripts, and related program functionality in the
Transcripts area.

Interface element Description

Case properties panel Right-click the panel to access the case media paths
and case properties. For more information, see: Set
Presentation Options, Change the Default Case Path,
and  Preferred Media Paths.

Transcript list Lists all the transcripts that have been imported into
the case.

Navigation bars These provide access to exhibits, media, transcripts,
and presentations.

Navigation Pane minimize button This button minimizes the navigation pane. Use this
as an alternative to options on the VIEW tab. For
more information, see: Customizing the Layout.
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Transcript highlighting* When a synchronized transcript is playing, the current
line is highlighted with the color of your choice. 
Highlight color can be changed by opening the
Sanction Options dialog box. For more information,
see: Set Presentation Options.

Paging controls Using these controls, you can: page through the
transcript one page at a time, go to the first or last
page, or go to a page by typing.

Search bar Use this to search for text within the selected
transcript. Buttons allow you to move forward and
back between search hits.

Transcript window With the transcript window, you can select text and
then right-click to create a text clip. 

In addition, if the transcript has synchronized media,
when you right-click a selection, you can create a
media clip.

Clip list* The list of clips created from the selected
synchronized transcript.

Media player* Plays the video of the transcript. The transcript text
remains in sync as you use the media player to go to
different parts of the transcript.

Clip Creator* Use this to create and edit media clips from the
selected synchronized transcript.

* Feature becomes available when a synchronized transcript is selected.

The Transcripts navigation bar
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When you click the Transcripts navigation bar, the button groups of the HOME menu change to
reflect options available when working with transcripts and synchronized transcripts.

Home tab when Transcripts navigation bar is selected

Shortcut keys - HOME > Transcripts

Group > Button Task Shortcut

New > Import
Import exhibits, media, transcripts, exhibit load
files, and clip lists.

Ctrl+I

New > Media
Clip

Create a new media clip from selected lines in 
a synchronized transcript.

Ctrl+Alt+M

New > Text Clip
Create an image of the selected transcript
text.

Ctrl+Shift+X

New > Video
Still

Create a new video still from a frame in a
synchronized transcript.

Ctrl+Shift+X

Actions >
Rename

Rename the selected transcript. F2

Actions > Edit Edit transcript properties. Ctrl+Shift+I

Actions > Delete Delete the selected transcript. Ctrl+D

Add To >
Presentation

Add the selected transcript to the existing
presentation of your choice. Or create a new
presentation from a selected transcript.

Ctrl+Shift A

Add To >
Playlist

Add selected clip (from a synchronized
transcript) to an existing transcript, or create a
new transcript from the selected clip. 

Ctrl+Y

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected transcript in
the presentation window.

Ctrl+S

Share > Export
Export exhibits, clips, playlists, and duration
list reports. 

Ctrl+Shift+E

Search > Find
Items

Search for items by item properties, such as
name, exhibit number, trial number, Bates
number, or description.

Search for items by admit date or transcript
date. 

Ctrl+F
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Related Topics

Customizing the Layout

Keyboard Shortcuts

HOME - Presentations Area

You can access presentations and their contents in the Presentations area.

interface element Description

Case properties panel Right-click the panel to access the case media paths and
case properties. For more information, see: Set Presentation
Options, Change the Default Case Path, and  Preferred
Media Paths. 

Presentation list The presentation list shows all of the presentations in your
case. The Default Presentation is a blank presentation that is
built into every case. In the screen capture above, Hawkins
Examination is an example of a presentation created by a
user.

Navigation bars These provide access to exhibits, media, transcripts, and
presentations.

Navigation Pane minimize
button

This button minimizes the navigation pane. Use this as an
alternative to options on the VIEW tab.
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Presentation item list This is the list of items in the selected presentation.

Item viewer window Shows a preview of the currently selected item. Switches
modes between exhibit viewer, media viewer, transcript
viewer, or synchronized transcript viewer, depending on the
item type selected.

Layout tools Provides options to fit and zoom the selected image in the
viewer.

For more information on these controls, see: Creating a Presentation , Adding and Removing
Items , and Opening and Closing Presentations.

The Presentations navigation bar

When you click the Presentations navigation bar, the button groups of the HOME menu change
to reflect options available when working in the presentations area of the main program
window.

Home tab when Presentations navigation bar is selected

Shortcut keys - HOME > Presentations
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Group > Button Task Shortcut

New > Import
Import exhibits, media,
transcripts, exhibit load files,
and clip lists.

Ctrl+I

New > New
Presentation

Create a new presentation. Ctrl+Shift+N

Actions >
Rename

Rename selected
presentation. 

F2

Actions > Delete Delete selected
presentation. 

Ctrl+D

Actions > Move
Up

Move selected items up in
the presentation.

Ctrl+Alt+U

Actions > Move
Down

Move selected items down in
the presentation. 

Ctrl+Alt+D

Actions >
Remove Item

Remove selected items from
the presentation. 

Ctrl+Alt+R

Add To >
Presentation

Add the currently selected
item to a different
presentation, or create a
new presentation from a
selected item.

Ctrl+Shift+A

Present >
Presentation

Open the selected
presentation.

Ctrl+Shift+F1

Present > Show
Item

Open the selected item in
the presentation window.

Ctrl+S

Share > Export
Export exhibits, clips,
playlists, and duration list
reports.

Ctrl+Shift+E

Display Mode

Only active when
presentation window is
open.

When View Mode is set to
Side By Side, 3 Across, or 4
Quadrants:

Allows you to move
through your presentation
using any item window.

Prevents new item
windows from opening.

Ctrl+Shift+T 

(Toggles on/off)
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Display Mode
(locked)              

Display Mode
(unlocked)

View Mode

Allows you to select
between Full Screen, Side By
Side, 3 Across, or 4
Quadrants.

Only active when
presentation window is
open.

Regardless of which View
Mode is selected, when you
open a presentation, the
window opens as a Full
Screen.

Full Screen: Ctrl+Shift+Up Arrow

Side By Side: Ctrl+Shift+Left Arrow

3 Across: Ctrl+Shift+Right Arrow

4 Quadrants: Ctrl+Shift+Down Arrow

Related Topics

Customizing the Layout

Keyboard Shortcuts

VIEW Tab

You can control the layout the main program window and send your presentations to a second
monitor by using the options on the VIEW tab.
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The VIEW tab

Group > Button Task Shortcut

Layout > Details View
Change the details view of exhibits to left,
minimized, or right.

Ctrl+Alt+V 

Layout > Details View
Show normal or minimize navigation panes. Ctrl+Alt+N

Monitors

Show presentations on a second display, such
as an external monitor or projector. 

For more information, see: Presenting on a
Second Display

Ctrl+Alt+Y 

Related Topics

Customizing the Layout

Keyboard Shortcuts

IMAGE TOOLS Tab

You can add sophisticated, multilayered annotations to exhibit pages by using the tools on the
IMAGE TOOLS tab.  

To access the IMAGE TOOLS tab, you need to first select an exhibit page, either in the Exhibits
area or the Presentations area. When the IMAGE TOOLS tab is selected, the following button
groups are available.

The IMAGE TOOLS tab

Group > Button Task Shortcut

Tools > Select Selection tool. Ctrl+Shift+S
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Tools > Crop Crop and zoom. Ctrl+M

Tools > Tear Out Magnify a selected part of the page and
move the selection around.

Ctrl+O

Tools > Magnifier Drag a magnifier across the exhibit. Ctrl+Alt+G

Tools > Pan Drag a zoomed page around in the exhibit
viewer window.

Ctrl+Alt+P

Tools > Erase

Erase annotations one at a time.

Note -- in the presentation window, the
shortcut key for Erase is Ctrl+D .

Ctrl+Alt+S

Tools > Delete
Annotations

Delete all of the annotations or exhibit
stamps applied to selected exhibit pages.

IMPORTANT

In presentation window, Ctrl+Delete
immediately deletes all visible annotations.

Ctrl+Delete

(IMAGE TOOLS tab
only)

Annotations > Highlight Create a transparent rectangle. Ctrl+H

Annotations > Arrow Draw an arrow. Ctrl+W

Annotations > Line Draw a line. Ctrl+L

Annotations > Pen Draw a freehand line. Ctrl+N

Annotations > Rectangle Create an unfilled ellipse. Ctrl+G

Annotations > Ellipse Create an unfilled rectangle. Ctrl+E

Annotations > Redaction Create a filled rectangle. Ctrl+R

Annotations > Text Type text into the exhibit. Ctrl+Alt+X

Options > Line Size Set the line thickness for: arrow, line, pen,
rectangle, and ellipse.

Ctrl+Alt+I

Options > Line Color Set the line color for: arrow, line, pen,
rectangle, and ellipse.

CTRL+Alt+O

Options > Fill Color Set the fill color for: highlight, redaction,
and text box.

Ctrl+Alt+F

Layers > 1 - 9

Select a layer and show it if it is hidden.

For more information, see: Annotation
Layers.

Ctrl+[Layer#] 

(e.g. 2 - 9)

Image > Rotate Right Rotate page right. Ctrl+Period

Image > Rotate Left Rotate page left. Ctrl+Comma

Image > Print Print the selected exhibit page. Ctrl+Shift+P

Related Topics

Customizing the Layout

Keyboard Shortcuts

Presentation Window

The presentation window is what your audience will see when you run your presentation. By
default, the presentation windows opens a single item at a time, however, the presentation
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window can be divided into multiple item windows. You can control the presentation window
using tools available in the presentation task bar and in each item window. You can also control
the presentation from the main program window, if the presentation is running on a second
display. 

This topic describes the functional areas and controls of the presentation window.

Presentation window controls

The Presentation Window

interface element Description

1. Item windows

The presentation window can show up to four item windows
simultaneously. The screen shot above shows the presentation
window hosting 3 item windows: a time line image on the left, a
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synchronized transcript in the center, and a document exhibit
on the right. For more information, see: Displaying Multiple Item
Windows.

2. Item window controls Each item window is equipped with its own set of controls:

1. Item selector. Use this to open an item by typing its name or
by selecting it from a list.

2. Annotation tools. Use this to access annotation tools.

3. Page fit and layers. Use this to adjust the page layout and
work with the annotation layers of an exhibit. 

For more information see: Setting Presentation Options, and
Annotation Layers.

3. Presentation taskbar The taskbar provides tools for you to control the presentation.
The task bar can be hidden or otherwise configured. For more
information, see: Setting Presentation Options.

The taskbar has the following components: the presentation
selector, task

4. Presentation selector Lists all the presentations in the case. 

Select this to:

Switch from presentation to presentation.

Close the presentation window. 

For more information see: Opening and Closing
Presentations.

5. Presentation window
buttons

Each open item window gets its own button in the taskbar.  

A blue border around the item name indicates the item is the
one that is active in the presentation window. 

6. Presentation window
controls

The presentation window is equipped with a set of controls:
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1. Next item/Previous item. Use these to move back and
forward between items in the presentation.

2. Item selector. Use it to: 

o Select items to display from a list of the items in the
presentation. 

o Access a search box for opening an item by typing a name,
exhibit number, trial exhibit number or Bates number. 

o Create screen captures. 

3. View Mode. Use this to configure the presentation window
to display as: Full Screen, Side-by-Side, 3 Across, and 4
Quadrants. 

4. Display Mode. Works in conjunction with the View Mode.
When unlocked, you can suspend new item windows from
opening, regardless of the View Mode setting. It also allows
you to select which item window you want to use to move
through the presentation.

 Display Mode locked         Display Mode unlocked

For more information, see: Displaying Multiple Item Windows.

5. Presentation options This button opens the Sanction Options dialog box, which
contains settings that govern: item display, item borders, tear
out borders, media playback, task bar options, and text
appearance for transcripts.

For more information on these controls, see: Controlling Item Presentation.

Presentation window shortcut keys

Action Key combination

Full Screen view mode F11 

or

Alt+Shift+Up Arrow

Side by Side view mode Alt+Shift+Left Arrow 
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3 Across view mode Alt+Shift+Right Arrow

4 Quadrant View  Alt+Shift+Down Arrow 

Rotate image counterclockwise Ctrl+Comma

Rotate image clockwise Ctrl+Period

Select Ctrl+Shift+S 

Crop/Zoom Ctrl+M 

Tear out (in presentation window) Ctrl+O 

Pan In the presentation window,
there is no shortcut key for the
Pan tool.

In the main program window, 
Ctrl+Alt+P activates the Pan
tool.

Erase Ctrl+D in the presentation
window.

In the main program window, 
Ctrl+Alt+S activates Erase tool.

Delete all visible annotations Ctrl+Delete 

In presentation window, this
shortcut deletes all visible
annotations.

In main program window, this
shortcut activates the Delete
Annotations menu item.

Highlight Ctrl+H

Arrow Ctrl+W 

Line Ctrl+L

Pen Ctrl+N 

Rectangle Ctrl+G

Ellipse Ctrl+E 

Redaction Ctrl+Shift+R 

Play\Pause media Ctrl+P 
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Show previous item Ctrl+Left Arrow

Show next item Ctrl+Right Arrow

Close all other item windows Ctrl+Shift+F4 

Display Mode lock/unlock Ctrl+Shift+T 

Zoom in/out exhibit page (using mouse) Ctrl+Mouse wheel forward 

or 

Ctrl+Mouse wheel back 

Zoom in exhibit page (using keyboard) Ctrl+Plus

or 

Ctrl+Equal

Zoom out exhibit page (using keyboard) Ctrl+Minus

Next presentation 

Previous presentation

Ctrl+Alt+P 

Shift+Alt+P

Clear presentation window Esc

Close presentation window Shift+Esc 

Close all item windows Shift+F4 

Select next item window Tab

Select previous item window Shift+Tab 

Layer visibility Ctrl+[Layer#] (e.g. 2 - 9) to
toggle on/off

Show next hidden layer F12 

(not available in main program
window)

Hide last visible layer Shift+F12

(not available in main program
window)

Capture F7 

Page up and page down through a multi-page
exhibit

Page Up

Page Down 
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Page forward like a book Ctrl+J

Related Topics

Customizing the Layout

Keyboard Shortcuts

Cases

Create, Open, and Pin Cases

To get started in Sanction you create a case. It is highly recommended that when you create
cases on your local computer, rather than saving them to a sever. Working on cases located on
a network can corrupt case backup files.

Sanction automatically creates backup files. 

Once you create a case, the next time you open Sanction you can find your case listed in
Recent Cases list, which is available from the Open area of the FILE tab. If you know you will be
working on the case and you do not want it to be replaced on the Recent Cases list, you can
pin cases to the Recent Cases list.

To create a case

1. Start Sanction.

If a case already open, click the FILE tab to access the case file panel.

2. Click Open, and then click New Case.

3. Browse to the folder where you want to save the case, type a name for the case file,
and then click Save.

The case is created and it opens in Sanction.

To open a case

1. Start Sanction.

If you already have a case open, click the FILE tab item to access the case file panel.

2. Click Open.

3. Do either of the following: 

Click Recent and then select a case from the Recent Cases list.
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Click Browse, click Browse again, click the Sanction case file (.lns3), and then click
Open.

To pin a case to the Recent Cases list

1. On the FILE tab, click Open, and then click Recent.

2. In the Recent Cases list, click the next to the case that you want always to appear in
the list.

If you want to remove the case from the pinned cases list, click the pin again. 

Related Topics

Sample Sanction Case

Change the Default Case Path

Practice with a Sample Case

With the Sanction sample case, you can begin experimenting with the features of Sanction. You
can reset the sample case to its original state whenever you want to. 

To open or reset the sample case

1. On the FILE tab, click Open. 
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2. Select Sample Case.

3. Select one of the following depending on what you want to do:

Open opens the sample case in the state it was in when you last closed it. 

Refresh opens the sample case in its original state.

Related Topics

Create, Open, and Pin Cases

Quick Start Guide

Navigating Sanction

Customizing the Layout

Preferred Media Paths

Default Folders and Item Types

User Folders

Items & Folders

Default folders and item types

When you create a case, several default folders are visible in the folder list. This topic describes
these folders and the kinds of items each can contain. 

By default, Sanction creates the following high-level folders for each case: Exhibits, Media,
Playlists, Transcripts, and Presentations.

The folders described in this topic relate to the set of folders and subfolders that you see
when you open a case in Sanction. For information about Sanction folder structure in the
Windows file system, see: Moving Cases and Media Files.

The Exhibits Folder

You can add PDFs and image files to the Exhibits folder and its subfolders, either by
importing files or by creating new screen captures, text clips and media stills from within
Sanction.  

The Exhibits subfolders are:
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By default, the Exhibits folder contains a Documents folder and an Images folder.

Documents. This folder is provided as an initial storage location for exhibit documents.
You can create additional folders within the Documents folder. 

Images. This folder is provided as an initial storage location for images. However, the
Images folder also contains several default subfolders of its own, with each serving a
specialized purpose:

Captures. This folder is where Sanction puts any screen captures that you create. In
Sanction, a screen capture is an image that you can create while viewing an exhibit
either in the exhibit viewer or in the presentation window. For more information, see: 
Screen Captures.

Text Clips. This folder is where Sanction puts any text clips that you create. A text clip
is a kind of image that you create in Sanction from the text you select while viewing a
transcript. For more information, see: Text Clips.

Timelines. This folder is designated to hold timeline images, such as those created in
LexisNexis TimeMap®.

Video Stills. This folder is where Sanction puts any video stills that you create. A video
still is an kind of image that you can create in Sanction when using the video player.
For more information, see: Video Stills.

The default folders do not enforce any file management scheme. For example, there is
nothing to prevent you from putting image files into the Documents folder or PDF files
into the Images folder.

In addition to the default folders, you can create custom folders anywhere within the
Exhibits folders. 

You can apply annotations to any item in the Exhibits folder and its subfolders. 

The Media Folder

The media folder may contain individual audio files and video files that you import, plus
any clips that you make from them in Sanction after import. By default, the Media folder
contains a Videos subfolder, which is provided to help you organize the media you import
initially. Like the Exhibits folder, you can create your own folders under the Media folder.
For information on getting media into your case, see: Importing Media.
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Playlists

A playlist is a series of media clips that you assemble within Sanction to form a single
media piece. For more information on creating media clips, see: Media Clips. For
information on assembling clips into playlists, see: Playlists.

Transcripts

Sanction supports many common transcript formats. After you import a transcript, it is
accessible via the Transcripts navigation bar. For information on getting transcripts into
your case, see: Importing Transcripts.

Presentations

This folder holds the presentations you create, as well as the Default Presentation,
which is built into Sanction and contains no items initially. For information about creating
presentations, see: Create a Presentation.

Related Topics

User Folders

Moving Exhibits and Media

Screen Captures 

Text Clips

Video Stills

Import Overview

Deleting items

Deleting an item removes it from the case. Here are some considerations to keep in mind, when
deleting an item.

Deleting Exhibits

When you delete an exhibit, any annotations that you have applied to it are deleted as
well, and the exhibit is removed from any presentations it was added to. However, any
screen captures you may have created from the exhibit as well as any annotations made to
the screen capture, are not deleted. 

Exhibit pages cannot be deleted independently from the exhibit to which they belong.

Deleting Media

Deleting a media item from within Sanction does not delete the media source file from the
file system, it just breaks the link from the case to the media file. 

When you delete a media item from Sanction, any clip that you created from the media item
is also deleted from the case. This includes clips already added to presentations and
playlists. However, video stills created from the media item are not deleted nor are any
annotations applied to the video stills. 

Deleting Transcripts

When you delete a text transcript, it is removed from the case. 
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The screen captures from exhibits and video stills from media, and any text clip made from
the deleted transcript, remains as an exhibit in the case. When you delete a transcript from
the case, it is removed from any presentations it was added to. 

When you delete a synchronized transcript, the transcript is removed from the case, but the
video remains in its Sanction folder.

Deleting Playlists, Presentations, and Folders

If you delete a playlist, the items that were a part of it remain in the case. 

To remove an item from a presentation, select the item and use the Remove Item
command. Ctrl+Alt+R. Do not use the Delete command when a presentation item is
selected as doing so will delete the entire presentation.

If you delete a presentation, the items that were a part of it remain in the case. 

You can delete any folder that you create, as long as the folder does not contain any items.

To delete items

1. On the HOME tab, click the Exhibits, Media, Transcripts, or Presentations navigation
bar, depending on the type of item you want to delete. 

2. Select the item you want to delete.

Items, such as exhibit pages and transcripts, are not deleted from presentations, they
are removed. Accordingly, if you want to remove an item from a presentation, you must
select the item then then click Remove Item. Do not use the Delete command to
remove items from presentations as doing so will delete the presentation.

3. Do one of the following:

In the Actions group, click Delete.

Right-click the item and then click Delete.

Press Ctrl+D.

4. In the confirmation dialog box, click Yes. 

Related Topics

Moving Exhibits and Media

Default Folders and Item Types

Editing item properties

A property is a type of information about an item. Item name, exhibit number, and description
are all examples of properties.

Additionally, the following facts pertain to item properties:

Each item type supports a different set of properties. For example, presentations have just
the name property, whereas videos, in addition to the name property, have exhibit number,
trial exhibit number, admit date, description, and file name.
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Certain item properties are editable and others are not. For example:

For videos, all properties but file name can be edited. 

For transcripts, all but the page count property can be edited. 

The name property of most items can be edited by right-clicking the item and then selecting
Rename or Edit. Note that exhibit names are editable, but not the names of individual
exhibit pages.

Other properties, when they apply, can be accessed via the Edit command. Select the item
you want to change the property for, and then, on the HOME tab, click Edit. 

Individual exhibit pages cannot be edited. 

 Several wizards are available for bulk renaming and renumbering exhibits. For more
information see: Wizards for Renaming, Renumbering, and Bates Numbering.  

To rename an item

1. Select the item that you want to rename.  

2. Do any of the following:

Right-click the item, and then click Rename.

On the HOME tab, in the Actions group, click Rename. 

On the HOME tab, in the Actions group, click Edit.

Press F2.

3.  Type the new name and then press Enter.

To edit or view other item properties

1. Select the item whose properties you want to view or edit.

2. Do one of the following:

On the HOME tab, in the Actions group, click Edit.

Right-click the item, and then click Edit.

Press Ctrl+Shift+I.

The item properties dialog box opens.

3. View or edit properties as provided by the dialog box, and then click OK.

Related Topics

Wizards for Renaming, Renumbering, and Bates Numbering

Searching for Case Items
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User Folders

You can create new folders within the Exhibits or Media folders, and then import or move items
into the folders you created. You can also rename, move, or delete the folders you create. The
folders you create can be nested within other folders, including the default folders that
Sanction creates. 

To create a folder

1. On the HOME tab, click either the Exhibits or Media navigation bar, depending on the
type of item the folder will hold.

2. In the New group, click New Folder or press Ctrl+Shift+F3.

The Create New Exhibit Folder dialog box opens. 

3. Type a name for the folder and then select a destination folder.

4. Click OK. 

The new folder is created in the folder that you selected.

To rename, move, or delete a folder



Using Sanction 45

© 2019 LexisNexis. All rights reserved.

1. Select the folder.

2. Select an option, depending on what you want to do:

Option Steps

Rename
1. Click Rename Folder. 

2. Type the new name for the folder and then press Enter.

Move
1. Click Move Folder.

2. Select the new folder location and then click OK. 

Delete

Click Delete Folder. 

To delete a folder, it must be empty.

If the folder options are shaded, it means that one of the default Sanction folders is
selected. The default folders cannot be renamed, moved, or deleted. 

For more information on the default folders, see: Default Folders and Item Types.

Related Topics

Default Folders and Item Types

Deleting Items

Moving Cases and Media Files

Moving Exhibits and Media

Importing files

Import Overview

With Sanction, you can import common file formats used in courtroom presentations for



LexisNexis Sanction46

© 2019 LexisNexis. All rights reserved.

exhibits, media, and transcripts. 

Supported file formats and their destinations

You can import many common file formats into your case by using the import utility from
either FILE > Info > Import, or HOME > Import. You also have the option to drag and drop
exhibits or media items directly on the folders where you want these items to go. 

For each file format, a specific area of the item tree is reserved as a destination. 

These file formats: Can be imported into this folder:

Bitmap .bmp

Gif .gif

Jpeg .jpg, .jpeg

Portable Document Format .pdf

Png .png

Tif .tif, .tiff

Exhibits and subfolders

Video .avi, .mpg, and .wmv.

 Note that the .mov format is also supported but

requires Apple QuickTime® for replay.

Audio .mp3, .wav. wma

Media f ile formats other than those listed here,

for example MP4 video, may also be imported.

How ever playback of these f iles may require

additional codecs to be installed on your

computer. For more information about codecs for

Window s® Media Player 12 and Window s 7, see

the Window s 7 Codec FAQ page.

Media and subfolders

Text .txt

Portable transcript .ptf

TextMap® Evidence Format .xmef

TextMap Portable Transcript .xmptf

Sanction MDB .mdb

Transcripts list

 

http://windows.microsoft.com/en-us/windows/codecs-frequently-asked-questions#codecs-frequently-asked-questions=windows-7
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What can prevent a file from being imported?

Sanction prevents incompatible file types from being imported. A file is prevented from import
in cases where the file is:

Corrupt.

Password protected.

Unsupported for the type of item you are trying to import.

If you try to import a set of files that contains incompatible files, Sanction will proceed with
the import of compatible files and provide notification that some files were skipped. For
example, if you run the Exhibit Import Wizard and include a folder that contains a mixture of
PDFs, plain-text transcripts and media files, only the PDFs will imported into the Exhibits
folder.

What happens when I import duplicates?

If you import a file with the same file name as one you already imported, Sanction will alert
you of the duplicate file name. 

For duplicate file imports, you can do the following:

Rename the file manually by using the Rename Duplicates feature in the File Import
Wizard.

Overwrite the existing file if no duplicate is desired.

Accept the current naming convention in which Sanction adds "-dup" to the name of the
newly imported item. 

This rule holds across the entire case independently of file extension. For example, if a
transcript file named MyFile.txt is imported as a transcript, it will appear in the transcript
list as MyFile. After that, if a different transcript file named MyFile.mdb is imported, it will
appear in the list as MyFile-dup. If a third file in then imported, this time an exhibit
named MyFile.pdf, it would list in the Exhibits folder as SomeDeposition-dup(2). 

The File Name is the criteria used for the duplicate check.

Related Topics

Importing Exhibits

Importing Media

Importing Transcripts

Importing Exhibits

To import exhibits, you can either drag and drop them into the Exhibits tree in Sanction, or you
can run the Exhibit Import Wizard, which is available from FILE > Info > Import or from HOME
> Import. To import a series of scanned files as one exhibit, use the Exhibit Import Wizard. 

Any files that are not PDF or image files are automatically omitted from being imported. 
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If you import folders, Sanction creates new folders in the Exhibits tree that mirror those you
import.

When you import files, Sanction copies the source files to your case. The import process
does not move or change the source files in any way. 

File and page naming conventions

When you import exhibits, Sanction assigns a name to each exhibit and exhibit page. It also
numbers the exhibit pages. Naming and numbering are determined as follows:

The exhibit name is drawn from the file name without the file extension. For example, a
file named BalanceSheet.pdf, when imported would appear in the exhibit list as
BalanceSheet.

Page names consist of the exhibit name followed by a dash (-) separator and a page
number. The exception to this is the first page, which is composed only of the name of
the exhibit without the separator or number.

Page numbering reflects the page count of the original document.

After the import, you can change exhibit properties, such as name, page numbers, Bates
numbers, and more. For more information about changing exhibit properties individually,
see: Editing Item Properties. For more information changing multiple exhibit properties at
one time, see: Wizards for Renaming, Renumbering, and Bates Numbering.

Combining multiple files into one exhibit

By default, when you import a set of image files, each file is imported as an individual exhibit.
However, when you use the Exhibit Import Wizard, you are given the option to combine all
the image files you are importing into a single exhibit. 

The option to combine files is not available via drag and drop import. 

Combining files is an all-or-nothing operation. When you run the Exhibit Import Wizard, and
you select the option to combine files into one exhibit, all of the files imported in that import
session are combined. When you use the option to combine files, take care to include only
files that all belong to that one exhibit. 

Example

Suppose Alice wants to import 3 exhibits. Two of the exhibits are multi-page PDF files:
Contract_A.pdf and Contract_B.pdf. The third exhibit, is a scanned report comprised of
several TIF files. To be certain that each exhibit retains its identity as a separate exhibit in
the case, Alice runs the import wizard twice. 

The first time she runs the import wizard, she selects just the two PDFs. After the import,
each PDF appears in the exhibit folder as a separate exhibit.

The second time she runs the import wizard, she selects the TIF files. Because all the TIF
files belong to the same exhibit, in the import wizard she uses the option to combine all the
files into one exhibit. After the import, all of the TIF files are combined into a single exhibit.

To import exhibits by using drag and drop
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1. With a case open, click the Exhibits navigation bar.

The Exhibits folders are listed.

2. Drag and drop exhibit files or folders into a folder on the Exhibits tree.  

The Drag & Drop File Import dialog box confirms the file import by providing a count of
the number of files that were imported and notes if any files were not imported. If you
dropped folders, Sanction creates new folders in the Exhibits tree that mirror those you
dropped. 

3. Do one of the following:

To finish the import without numbering or renaming, click Close.

To renumber the exhibits, click Launch Exhibit Numbering Wizard, then follow the
steps in the wizard.

To rename the exhibits, click Launch Exhibit Renaming Wizard, then and follow the
steps in the wizard 

For more information on renaming and renumbering, see: Wizards for Renaming,
Renumbering, and Bates Numbering.

To import exhibits by using the import wizard

1. With a case open, do one of the following:

Press Ctrl+I.

On the FILE tab, click Info, click Import, and then click Exhibits. 

On the HOME tab, click Import. and then click Exhibits. 
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The Exhibit File Import Wizard starts.

2. Click Next. 

The Select Files to Import dialog box opens.
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3. Depending on whether you want to add files individually or by the folder, do one of the
following:

Click Add Files to add files individually. 

On the Select Files to Import dialog box, browse to the folder that contains the files,
select the files, and then click Open.

or

Click Add Folder to add an entire folder and its contents.

Browse to the folder location, select the folder, and then click Select Folder.

Repeat the steps as needed to add more files.

To remove one or more files, select the file(s) and then click Remove Files. To remove all
files, click Remove All.

4. Click Next. 

The Select Import Destination Folder dialog box opens.
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5. Select a destination folder and then click Next. If necessary, you can click New Folder
and then create a new folder to use as the import destination.

6. This step depends on whether you have selected a single file for import or multiple files.

If all of the files selected for import are image files, the Combine Files dialog box opens. 

Do one of the following, depending on whether the files should all be combined into a
single exhibit.

Click Yes only if all the files belong to the same exhibit. 

If each file represents a different exhibit, keep the default as No, and then click Next. 

Click Cancel and then restart the wizard if some of the files should be combined and
others should not.
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The Ready to Import dialog box opens.
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7. Review the summary of your import selections and then click Next. 

The import proceeds. When completed, the Import Confirmation dialog opens. If any
error occurred during import, it is noted on the dialog box. 

If any duplicates were imported, it is noted in the dialog box.
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8. Do one of the following: 

Click Rename Duplicates.

Click Close if you choose to not rename the duplicate files.

The files are added to the case in the folder you selected.

9. If you choose the option to Rename Duplicates, the Rename Duplicates dialog box opens
and shows a list of the duplicate files imported. 

10. To rename the duplicates, double-click the file name.

You can also press F2 to rename the file. 

11. After you have renamed your duplicates, click Finish. 

To import exhibits by using a load file

With Sanction, you can bring exhibits into your case by importing load files formatted as
Opticon .LOG or as IPro LFP. 

1. With a case open, do one of the following:

On the FILE tab, click Info, click Import, and then click Exhibits. 

On the HOME tab, click Import, and then click Exhibits.
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2. In the Welcome dialog box, click Next.

The Select Files to Import dialog box opens.

3. Click Add File and then browse to the exhibit load file. 

4. Select the load file and then click Load.

The Select Files to Import dialog box opens again. 

5. Click Add File and then select a load file, or click Next to continue with the wizard.

6. Select the folder where you want to save the exhibits. 

If you want to create a new folder, then click New Folder, type a name for the folder,
select a destination folder, and then click OK.

The Ready to Import dialog box opens.

7. Verify your selection and then click Next.

The Import Confirmation dialog box opens, which provides a count of the files that were
imported.

8. Click Close.

To import multiple image files as a single exhibit

1. With a case open, do one of the following:

On the FILE tab, click Info, click Import, and then click Exhibits. 

On the HOME tab, click Import. and then click Exhibits.
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The Exhibit File Import Wizard starts.

2. Click Next. 

The Select Files to Import dialog box opens.
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3. Click Add Folder to add an entire folder and its contents. 

4. Browse to the folder location that contains the image files that you want to import as a
single exhibit, select the folder, and then click Select Folder.

After adding the items, you can add additional files and/or remove the ones added as
needed from the queue. To remove one file, select the file and then click Remove Files.
To remove all files, click Remove All.

5. Click Next. 

6. Add more items or remove items from the list as needed. 
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7. When your list contains all the files you want to import, click Next.

The Select Import Destination Folder dialog box opens.
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8. Select a destination folder and then click Next. If necessary, you can click New Folder
and then create a new folder to use as the import destination.
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9. Click Yes, combine the selected files..., and then click Next. 

 The Ready to Import dialog box opens.
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10. Review the summary of your import selections. If the file list and destination folder are all
right, then click Next. 

The import proceeds. When completed, the Import Confirmation dialog opens. If any
error occurred during import, it is noted on the dialog box. 
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11. Do one of the following: 

Click Rename Duplicates.

Click Close if you choose to not rename the duplicate files.

The files are added to the case in the folder you selected.

12. If you choose the option to Rename Duplicates, the Rename Duplicates dialog box opens
and shows a list of the duplicate files imported. 

13. To rename the duplicates, double-click the file name.

You can also press F2 to rename the file. 

14. After you have renamed your duplicates, click Finish. 

Related Topics

Import Overview

Import Media

Import Transcripts
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Wizards for Renaming, Renumbering, and Bates Numbering 

Moving Exhibits and Media

Adding and Removing Items

Importing Media

You can import video and audio files into your case. 

There are two ways to import media. You can either drag and drop folders and files directly into
a folder in the Media area, or you can run the Media Import Wizard, which is available from FILE
> Info > Import or from HOME > Import. 

If you import folders of media items, Sanction creates new folders in the Media tree that mirror
those you import.

To import media items by using drag and drop

1. With a case open, click the Media navigation bar.

The Media folders are listed.

2. Drag and drop files or folders into any folder in the Media tree, except Playlists. 

A dialog box confirms the file import by providing a count of the number of files that were
imported and notes if any files could not be imported.  

3. Click Close to finish the import.

To import media by using the import wizard
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1. Do one of the following:

Press Ctrl+I.

On the FILE tab, click Info, click Import, and then click Media. 

On the HOME tab, click Import. and then click Media. 

The Media File Import Wizard starts.

2. Click Next. 

The Select Files to Import dialog box opens.
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3. Depending on whether you want to add files individually or by the folder, do one of the
following:

Click Add Files to add files individually. 

On the Select Files to Import dialog box, browse to the folder that contains the files,
select the files, and then click Open.

or

Click Add Folder to add an entire folder and its contents.

Browse to the folder location, select the folder, and then click Select Folder.

Repeat the steps as needed to add more files.

To remove one or more files, select the file(s) and then click Remove Files. To remove all
files, click Remove All.

4. Click Next.

The Select Import Destination Folder dialog box opens.
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5. Select a destination folder and then click Next. If necessary, you can click New Folder
and then create a new folder as a destination for the import.

The Ready to Import dialog box opens.
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6. Review the summary of your import selections. If the file list and destination folder are all
right, then click Next. 

The import proceeds. When completed, the Import Confirmation dialog opens. It provides
a count of the number of transcripts that were imported. Any error that occurred during
import is noted on the Import Confirmation screen. 
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7. Click Close.

Related Topics

Import Overview

Import Exhibits

Import Transcripts

Moving Exhibits and Media

Preferred Media Paths 

Adding and Removing Items

Importing Transcripts

You can import transcripts into your case. 

There are two ways to import transcripts into your case. You can either drag and drop
transcripts directly into the transcripts list, or you can run the Transcripts Import Wizard, which
is available from FILE > Info > Import or from HOME > Import.

To import exhibits by using drag and drop
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1. With a case open, click the Transcripts navigation bar.

2. Drag and drop transcripts individually or by the folder to the list area just above the
navigation bars.  

A dialog box confirms the file import by providing a count of the number of transcripts
that were imported and notes if any were skipped. 

3. Click Close.

To import transcripts by using the import wizard

1. With a case open, do one of the following:

Press Ctrl+I.

On the FILE tab, click Info, click Import, and then click Transcripts. 

On the HOME tab, click Import. and then click Transcripts.

The Transcript File Import Wizard opens.

2. Click Next.
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The Select Transcript Files to Import dialog box opens. 

3. Click Add Files and then browse to the folder where the transcripts are located. Select
the transcripts you want to import and then click Open. The transcripts you selected are
listed in the dialog box. 

Repeat this step as needed to select more transcripts.

To remove one or more files, select the file(s) and then click Remove Files. To remove all
files, click Remove All.

4. Click Next.

The Ready to Import dialog box opens.

5. Click Next.

The selected transcripts are imported and the Import Confirmation dialog opens
displaying a count of imported transcripts. 

6.  Do one of the following: 

For this condition: Perform these steps:

None of the transcripts
you imported were
synchronized
transcripts.

Click Close. 

One or more of the
transcripts you
imported are
synchronized
transcripts.

AND 

The media files for the
synchronized
transcripts have not
been added to the
Media folder for the
case in the Windows
file system.

1. Click Select Media Paths. The Case Media Paths dialog box
opens.

2. Review the list of paths. 

3. Add paths as needed to make sure each media file can be
reached along a path.

o If a path already exists to a folder that is positioned
higher in the file system hierarchy than the folder that
contains transcript media, then click Edit, click Include
Subfolders, and then click OK.

4. When finished adding paths, click OK to finish working in
the Case Media Paths dialog box.

5. Click Close to complete the Transcript File Import Wizard.

Duplicates are
imported. 

1. Click Rename Duplicates.

2. Click Close if you choose to not rename the duplicate files.

3. The files are added to the case in the folder you selected.

4. If you choose the option to Rename Duplicates, the Rename
Duplicates dialog box opens and shows a list of the
duplicate files imported. 
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5. To rename the duplicates, double-click the file name.

You can also press F2 to rename the file. 

6. After you have renamed your duplicates, click Finish. 

         

Related Topics

Import Overview

Import Exhibits

Import Media

Preferred Media Paths

Synchronized Transcripts

Synchronizing Text and Video Files

Exporting files

Exporting Exhibits, Media Clips, Playlists, and Clip Lists

You can share and work with various files from your case(s) outside of Sanction.

The following export options are available:

Export Exhibits

Export Media Clips 

Export Playlists

Export Clip List (video or audio)

Export Portable Transcripts

You also export duration list reports. For more information, see: Duration List Reports.

To export exhibits

1. Do one of the following:

On the FILE tab, in the Info area, and then click Export. 

On the HOME tab, click Export.

2. Click Exhibits.

The Welcome dialog box opens.

3. Click Next.
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4. Open the folder that has the exhibits that you want to export.

5. Do either of the following, depending on what you want to export. 

Click Add All to add all the listed items.

Select individual files or folders and then click Add Selected. 

After adding items, you can remove them as needed from the queue. To remove one or
more items, CTRL+click or SHIFT+click items and then click Remove Selected. To
remove all items, click Remove All.

Items that are ready to be exported and are listed in the right panel of the dialog box.

6. Click Next. 

The Select... dialog box opens.
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7. Select options as follows:

Destination. Select the default, which is to the Documents folder for the currently logged
in Windows user, or click Browse and then select a different folder.

Burn-in options. These options control whether annotations that have been applied to
exhibits are saved to the page images on exported files. 

o All Layers. Saves all the annotations found on all layers to page images. 

o Layer 1 Only. Saves all exhibit stamps plus any the annotations found on layer 1 to
page images.

o No Burn-In. Prevents annotations and exhibit stamps from being saved on the image
files. This is the default option.

Export to native or PDF. This option is available in the section marked, "How would you
like to export your exhibits?"

o Convert all exhibits to PDF. Each exhibit in the export set is exported as a separate
PDF file.

o Keep original file type(s) on export. Each exhibit is exported using the file format it
had when imported. 

8. Click Next.

9. In the Ready to Export dialog box, review your selections and then click Next.

 The export proceeds, and then the Export Confirmation dialog box opens. 

10. Click Close to finish the wizard.

To export media clips
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1. Do one of the following:

On the FILE tab, click Info, and then click Export. 

Select the HOME tab and then click Export.

1. To export exhibits, click Exhibits, to export media clips, click Media Clips.

The Welcome dialog box opens.

2. Click Next.

3. Do either of the following, depending on what you want to export. 

Click Add All to add all the listed items.

Select individual files or folders and then click Add Selected. 

Items that are ready to be exported and are listed in the right panel of the dialog box.

4. Click Next. 

The Select Destination Location dialog box opens.
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5. Accept the default export path or click Browse to select a different folder. When ready,
click Next.

6. In the Ready to Export dialog box. click Next.

The Export Confirmation dialog box opens. 

7. Click Close.

To export playlists

1. On the HOME tab, in the Share group, click Export.

2. Click Playlists.

The export wizard starts.

3. Click Next.

4. Do either of the following, depending on what you want to export. 

Click Add All to add all the listed items.

Select individual files or folders and then click Add Selected. 

Items that will be exported now appear in the right panel of the dialog box.

5. Click Next. 

6. Accept the default export path or click Browse and then select a different folder.
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7. Click Next and then click Next again to complete the export.

8. Click Close.

To export a clip list

You can share your work with your team by exporting a clip list to a csv file. 

1. On the HOME tab, click the Transcripts navigation bar.

2. Select the synchronized transcript from the transcript list.

3. On the HOME tab, click Export.

4. Click Clip List.

5. The Clip list Export Wizard dialog box opens, click Next.

6. Click the folder that contains the video or audio clips that you want to export.

7. Do either of the following, depending on what you want to export: 

Click Add All to add all the listed items.

Select individual files or folders and then click Add Selected. 

After adding items, you can remove them as needed from the queue. To remove one or
more items, CTRL+click or SHIFT+click items and then click Remove Selected. To
remove all items, click Remove All.

Items that are ready to be exported and are listed in the right panel of the dialog box.

8. Click Next. 

The Select the Destination file dialog box opens.

9. Click the Browse button to navigate to the location where you want the clip list(s) saved.

10. Type the file name, click Save and then click Next.

The default destination is now set for your clip list(s).

11. In the Ready to Export dialog box, verify your clip list selections before exporting and
then click Next.

The clip lists are exported to the destination folder. 

12. The Export Confirmation dialog box appears to confirm the number of clips successfully
imported. Click Close to close the wizard. 

To export synchronized transcript packages

1. On the HOME tab, click the Transcripts navigation bar, and then select the synchronized
transcript you want to export.

2. On the ribbon on the Share group, click Export, and then click Portable Transcript.

The Portable Transcript Export Wizard welcome dialog box opens.
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3. Click Next.

4. The Select Destination Location dialog box opens.

5. Click one of the following file types, depending on the type of synchronized package you
want to export.

Sanction Format (mdb)

Portable Transcript Format (ptf)

TextMap Portable Transcript (xmptf)

6. Accept the default export path or click Browse to select a different folder. 

7. Create a new folder or select the new folder name, and then click Select Folder.

8. Click Next.

9. The Export Confirmation dialog box opens. 

8. Click Close to exit the wizard.

Related Topics

Annotation Tools

Media Clips
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Playlists

Duration List Reports

Exhibits

Add or Replace Exhibit Pages

You can replace an existing exhibit with a different version of it. When replacing an exhibit, the
replacement must be of the same file type as the original and must have the same number of
pages.

You can also add pages to an exhibit or replace pages. When you add pages, the replacement
pages must be the same file type as the original.  Any annotations that you applied to the
original page are transferred to the replacement. 

To add pages to an exhibit

1. Navigate to the exhibit you want to change.

a. On the HOME tab, click the Exhibits navigation bar. 

b. Open the exhibit folder that contains the exhibit.

2. Do either of the following:

Click the exhibit, and then on the HOME tab, click Update Exhibit, and then click Add
Page(s).

Right-click the exhibit, click Update Exhibit, and then click Add Page(s). 

3. Navigate to the file that contains the exhibit pages you want to add.

4. Select the file and then click Open. 

In the Exhibit Viewer, the pages in the file that you selected are added to the end of the
page list.

To replace exhibit pages

1. Navigate to the exhibit you want to change.

a. On the HOME tab, click the Exhibits navigation bar. 
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b. Open the exhibit folder that contains the exhibit.

2. Select the exhibit, and then on the HOME tab, click Update Exhibit.

3. Click Replace Page(s).

4. In the message box that says that all the images for the exhibit will be updated, click 
OK. 

5. Navigate to the file that contains the exhibit pages you want to add.

6. Select the file and then click Open. 

The exhibit pages are updated with the pages of the exhibit you selected.

Related Topics

Importing Exhibits

Editing Item Properties

Annotation Tools

You can access annotation tools in the exhibit window via the IMAGE TOOLS tab, and from the
Presentation window via the Annotation Tools Gallery button. 

In the main program window, annotation tools are available in the IMAGE TOOLS tab 
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in the Presentation w indow, annotation tools are available via the Annotation Tools Gallery button 

During a presentation, annotations made in the exhibit viewer of the main program
window can be made to be immediately visible in the Presentation window. Conversely,
annotations made in the Presentation window can be made to be immediately visible in
the exhibit viewer. However, for this reciprocity to work consistently, the annotation layer
to which the annotation was applied must be configured to be visible in both the exhibit
viewer and the Presentation window. For more information about annotation layers, see:
Annotation Layers.

List of annotation tools

Annotation tools are available in the main window and in the presentation window. For a list
of the Keyboard shortcuts for annotation tools, see: Keyboard Shortcuts. The function of
each annotation tool is described here:

Tool Description

Select
Selects annotations that have been added to the exhibit. 

Allows you to resize, reposition, and delete annotations.

Crop/Zoom

Zooms in on a rectangular area of the exhibit. 

Use this tool to draw attention to a part of the exhibit or in conjunction
with the Screen Capture tool to create a screen capture. For more
information on screen captures, see: Screen Captures. 

Tear Out

Creates floating zoom areas that can be resized, repositioned, or closed
as needed. Tear outs contains whatever annotations that were applied to
the exhibit as well as any that are created as the tear out is open. 

Dragging the mouse across the face of a tear out creates a highlighted
area on the exhibit.

The edge of tear outs can be set to smooth or to a ripped effect. 

For more information see: Tear Out Tool. 

Magnifier Creates a rectangular magnified area that can be moved around. 

Pan Moves the exhibit around in the exhibit window.

Erase Erases annotations, one at a time.

Highlight Creates a translucent highlighted rectangle. The default highlight color is
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yellow but it can be changed by selecting a different color from the Fill
Color control.  

Arrow Creates an arrow. 

Line Creates a line.

Pen Creates a freehand line.

Rectangle Creates an unfilled rectangle.

Ellipse Creates an unfilled ellipse.

Redaction Creates a filled rectangle. 

Text

Allows you to type text onto the exhibit. The text box is bordered and can
be moved or resized. You can also set the default font and font style. To
access font settings, on the FILE menu, click Options, and then click
Exhibits.

Note that this tool is available in the main program window only.

Line size and
Line color

Sets the line weight and color for arrows, lines, pens, rectangles, and
ellipses. 

Fill color
Sets the fill color for the highlight, rectangle, and ellipse. 

Sets the background color for text.

Layers Provides control over the visibility of annotations. For more information,
see: Annotation Layers. 

To annotate an exhibit from the IMAGE TOOLS tab

1. On the HOME tab, click the Exhibits taskbar. 

2. Select the exhibit you want to annotate.

3. Do one of the following:

Double-click the exhibit.

Select the IMAGE TOOLS tab. 

4. Annotate the exhibit by using the tools in the image toolbar. 

To annotate an exhibit from within the presentation window

1. In the presentation window, open the exhibit you want to annotate.

2. Select the annotation tool gallery button.
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3. Select an annotation tool and then apply the annotation to the exhibit. 

To set defaults for annotation tools

1. On the FILE tab, click Options.

2. Click Exhibits.

File > Options > Exhibits

3. Select options for annotation tools needed.
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Tool Options

Image Tool Select the default image tool as: Highlight, Arrow, Line, Pen, Rectangle,
Ellipse, Crop/Zoom, or Tear Out.

Annotation
Font

Change the default font, font size, and color of text annotations.

Tear Out

Change the default screen position of tear outs.

Change the default edge of the tear out from standard (smooth) to a
ripped edge.

PDF
Resolution

Increase the resolution of PDF pages. The default value is 96 DPI, with
stops at 150, 200, and 300.

4.  Click OK. 

You can also access Sanction options from the presentation window. In the
presentations window, select the presentation options button. 

To delete all annotations

You can delete all the annotations applied to exhibit pages in one operation. When you
delete multiple annotations in this way, you can choose whether to include or exclude
exhibit stamps in the delete operation.

 Select the exhibit or exhibit pages that you want to remove annotations from. 

1. Do either of the following:

Right-click the selected exhibit or exhibit pages and then click Delete Exhibit Page
Annotations. 

Click the IMAGE TOOLS tab, and then click Delete Annotations.

2. Click one of the following, depending on what you want to do:

Select this option: To accomplish this:

Delete All
Exhibit Page
Annotations

Delete all annotations, including any exhibit stamps.

Delete All
Excluding
Stamps

Delete all exhibits, but keep exhibit stamps.

Delete Only Delete all exhibit stamps, but keep all other annotations.



Using Sanction 85

© 2019 LexisNexis. All rights reserved.

Stamps

3. In the confirmation box, click Yes.

The annotations and/or stamps are deleted.

Related Topics

Annotation Layers

Tear Out Tool

Rotate Pages and Images

Annotating in Real Time

Annotation Layers

By applying annotations in layers, you can control the visibility of selected annotations, showing
them or hiding them as needed to suit the particular needs of your presentation. Annotation
layers can be controlled both from the main program window and from the presentation
window. This topic describes concepts and procedures that apply mainly to working in the main
program window. For more information about working with annotation layers while in the
presentation window, see: Annotating in Real Time. 

When you want to apply annotations in layers, consider the following:

Number of layers = 9. Each exhibit has 9 layers. Each layer may hold multiple annotations.

Layer 1 is always visible. Layer 1 is the only layer that cannot be hidden. Annotations
applied to Layer 1 is always visible in both the exhibit viewer and in the presentation
window. Note that exhibit stamps are applied only on Layer 1 so they are always visible.

Layers 2-9 can be set to visible or hidden. At any given time, Layers 2 through 9 can be
set individually to visible or hidden. 

You can control visibility in main window and presentation window. Control over layer
visibility is provided in both the main program window and in the presentation window. 
However, note that visibility of individual layers is set independently between the two
windows. For example, you can set Layer 2 to be visible in the main program window and
hidden in the presentation window. 

Initial visibility of layers. Initially, in the main program window, all layers are visible. But in
the presentation window, Layers 2-9 are initially hidden. 

Reciprocal visibility. Annotations applied from either window are immediately visible in the
other window as long as the layer to which the annotation is applied is set to visible in both
windows.

Moving away from an exhibit. In the presentation window, moving away from an exhibit
hides all layers except Layer 1.

To use annotation layers from the main program window

1. Select the Exhibits navigation bar.
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2. Select the page of the exhibit you want to annotate.

3.  Select the IMAGE TOOLS tab. 

In the Layers area, Layer 1 is selected by default.

 

Until another layer is selected, all new annotations are applied to Layer 1.

4. Add any annotations you want to appear at all times to Layer 1. 

Annotations placed on Layer 1 cannot be hidden. 

5. Select Layer 2 and then apply annotations to the exhibit. In the presentation window,
these annotations will be hidden initially.

6. Select the eye icon next to the layer 2 to show or hide the layer.  

7. Add more annotations to other layers as needed.

8. Practice presenting the exhibit, manipulating the visibility of layers until you are
comfortable with how they look. Several keyboard shortcuts are available for use with
annotation layers. For more information, see: Keyboard Shortcuts.

As an alternative to working with layers can also create multiple copies of the same exhibit
page and then apply different annotations to each copy. For more information, see: Save
as New Page. 

Related Topics

Annotation Tools

Tear Out Tool

Annotating in Real Time
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Keyboard Shortcuts

Exhibit Stamps

You can apply exhibit stamps to exhibit pages. Exhibit stamps can be configured in the following
ways:

Color. You can color your stamps as either blue, red, white, or yellow.

Optional fields. You can add one of the following fields to exhibit stamps: page name,
exhibit number, trial number, or Bates number. In addition, you can also add a case number
of up to 25 characters. 

Placement. You can select where on the page margin to apply the stamps. After stamps are
applied, they can be moved around on the page individually.

Size. After stamps are applied, you can change their size individually.

FILE > Exhibit Stamp Wizard

After you have applied the stamps, you can move, resize, or delete them individually via the
exhibit viewer or from within the presentation window. 

Stamps are applied to Layer 1 so they cannot be hidden when presenting the exhibits. As with
other annotations, exhibit stamps do not appear on exhibit printouts. However, exhibits
stamps can be made to appear on exported exhibits. For more information on exporting
exhibits see: Exporting Exhibits, Media Clips, and Playlists.

To apply exhibit stamps

1. In the Info area of the FILE tab, click Exhibit Stamp.

    

2. In the Welcome dialog box, click Next.

The exhibit selection dialog box opens. 
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3. Select items to stamp. 

Click Add All to add all the listed exhibits.

Select individual exhibits and then click Add Selected. 

Double-click individual exhibits.

After adding exhibits, you can remove them from the queue as needed. To remove one
or more exhibits, CTRL+click or SHIFT+click items and then click Remove Selected.
To remove all exhibits, click Remove All.

The exhibits to be stamped are listed in the right panel of the dialog box.

4. Click Next. 

5. Select options as needed:

Stamp type. This determines the title and color of the stamp.

Field. The following fields are available: page name, exhibit number, trial number, or
Bates number.

Case Number. You can enter up to 25 characters in this field.

Placement. Select a radio button to position stamp on the page.
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The default placement is bottom edge of page, centered.

Click Apply Exhibit Stamp to the first page only to have the stamp applied that
manner.

6. When options have been selected, click Next.

The Ready dialog box opens.

7. Review your selections and then click Next.

The exhibits are applied and the Exhibit Stamp Wizard Complete dialog box opens.

8. Click Close.

To move, resize or delete exhibit stamps

1. Open the exhibit in the presentation window or exhibit viewer.

2. Do one of the following:

To move the stamp. drag the stamp to a different part of the page.

To resize the stamp, select the stamp and then click and drag the exhibit stamp
handles. 

To delete a stamp, select it and then press the Delete key.

To delete all exhibit stamps

1. Select the exhibit or exhibit pages that you want to remove stamps from. 

2. Do either of the following:

Right-click the selected exhibit or exhibit pages, click Delete Exhibit Page Annotations,
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and then click Delete Only Stamps.

On the IMAGE TOOLS tab, click Delete Annotations, and then click Delete Only Stamps.

3. In the confirmation box, click Yes.

The exhibit stamps are deleted.

Related Topics

Printing Exhibits

Exporting Exhibits, Media Clips, and Playlists

Print Exhibits

You can print exhibits individually, in groups, or all at once. 

Note that when you print exhibits, any annotations that have been applied to exhibits,
including exhibit stamps, are not printed. To print exhibits with annotations showing, you
can export them using one of the burn-in options, and then print them from an external
application. To learn how to export exhibits and how to configure burn-in options, see: 
Exporting Exhibits, Media Clips, and Playlists.

To print exhibits

1. Select the Exhibits navigation bar.

2. Open the folder that contains exhibits you want to print.



Using Sanction 91

© 2019 LexisNexis. All rights reserved.

3. Do either of the following: 

Select an individual exhibit to print. Next, if the exhibit has more than one page, select
the individual pages you want to print. 

By default, when you select an individual exhibit, only the first page is selected to
print. If the exhibit has multiple pages and you want to print any others in addition to
the first page, you will need to select those pages in the page list. 

You can select multiple pages in the list by pressing Ctrl and clicking pages, or by
pressing Shift and clicking a range of pages.

Select more than one exhibit to print. 

When you select multiple exhibits, all pages of each selected exhibit are automatically
selected and will print.

You can select multiple exhibits in the list by pressing Ctrl and clicking exhibits, or by
pressing Shift and clicking a range of exhibits.

4. Do any of the following: 

Press Ctrl+Shift+P. 

Right-click any item that you selected to print and then click Print.

On the HOME tab, in the Share group, click Print.

5. Select print options as needed and then click Print.
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Related Topics

Annotation Tools

Exporting Exhibits, Media Clips, and Playlists

Rotate Pages and Documents

You can rotate individual pages of one exhibit or all the pages of one or more exhibits at a time.

To rotate an individual page

1. Select the page you want to rotate.

2. Do either of the following:

On the IMAGE TOOLS tab, click Rotate Right or Rotate Left.

Press Ctrl+Period to rotate right, or Ctrl+Comma to rotate left.

Use this procedure to change a single page. If you want to rotate all pages of one or
more exhibits at a time, use the procedure described below.

To rotate multiple exhibits at a time

1. Select the exhibits that you want to rotate.

2. Right-click one of the exhibits that you selected.

3. Click Rotate Pages and then click either Rotate All Pages Left or Rotate All Pages Right.
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For each selected exhibit, all of the pages will be rotated.

Related Topics

Annotation Layers

Tear Out Tool

Annotating in Real Time

Save as New Page

You can save a copy of an exhibit page or image and then apply annotations to the copy
without changing the original exhibit. 

Note the following:

Annotations that were already applied to the original are also copied over.  

The name of the new page is the same as the existing page but it has 3 digits appended. 
For example, if a new page were to be created from an page named ExhibitE, the new page
would be named ExhibitE.001.

Page copies are ignored by wizards for renaming, renumbering, and applying Bates
numbers.

Page copies cannot be exported.

The page count for the exhibit, as shown in the Pages column of the exhibit list, will reflect
the number of original pages. Pages that were saved as new are not counted.
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To save a page as a new page

1. On the HOME tab, click the Exhibits navigation bar. 

2. Select the exhibit that has the page you want to make a copy of. 

3. Right-click the page and then click Save as New. 

The new page is created in the page list above the original page. The new page will
have a 3 digit number appended to the end of its name. For example, if you were to
Save As New an exhibit page with the name, P001234, the new page will be named
P001234.001.

Related Topics

Annotation Tools

Annotation Layers

Setting Zoom and Page View

Text Clips

Video Stills

Adding and Removing Items

Screen Captures

You can create screen captures of the exhibit display window. Screen captures are saved as
new exhibits. 

By default, screen captures are added to Exhibits > Images > Captures folder. From there, they
can be added to presentations, moved, renamed, or deleted.
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Sanction puts screen captures in Exhibit > Images > Captures

To create screen captures

1. On the IMAGE TOOLS tab, click the Exhibits navigation bar. 

2. Select the exhibit page you want to make a screen capture of. 

3. In the Tools group, click Crop Zoom.

4. Select part of the image you want to create a capture of. 

Note that only that part of the page or image that is shown in the exhibit viewer will be
captured. As an alternative to using the Crop Zoom tool, you can use the scroll bars,
magnification slider, and the page layout controls to size and position the window the
way you want the capture to look.

5. Press F7, or on the HOME tab, click Capture.
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6. Type a name for the capture and then click OK. 

The capture is saved to the Exhibits > Images > Captures folder.

Related Topics

Annotation Tools

Annotation Layers

Setting Zoom and Page View

Text Clips

Video Stills

Adding and Removing Items

Tear Out Tool

As you run a presentation, you can use the tear out tool to temporarily magnify one or more
rectangular areas of an exhibit. Tear outs can be created from within the presentation window
by accessing the annotation tools gallery, or they may be created in the main program window
from the IMAGE TOOLS tab.

Note the following considerations when using the tear out tool:

Tear outs can be annotated, resized, and moved.

You can make multiple tear outs on an exhibit. 

Tear outs do not persist after moving to another item or closing the presentation. 

Tear outs display on Layer 1, which means that until you close a tear out, it remains visible
regardless whether other layers are set to be visible or not.

Dragging the mouse across a tear out creates a highlighted area on Layer 1 of the exhibit
page. The highlight persists on Layer 1 after the tear out is closed. For more information on
layers, see: Annotation Layers.

Unlike other image tools, tear outs created in the main window are not reflected in the
presentation window. For this reason, tear outs created in the main window are typically
used for practice purposes only.

To access the tear out tool, open the tools gallery of the presentation window. Or click the
IMAGE TOOLS tab in the Exhibits area of the main window.

To create a tear out from the presentation window
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1. In the presentation window open the exhibit you want to use the tear out tool on. 

2. Do either of the following:

Press Ctrl+O.

Click the annotation tools button located on the lower right corner of the item window,
and then select the Tear Out tool.

Tear Out tool in the presentation w indow

3. To create the tear out, drag across the exhibit. When you release the mouse, the tear
out displays on top of the presentation.

To create a tear out from the IMAGE TOOLS tab

1. Select the exhibit you want to use the tear out tool on. 

2. Select the IMAGE TOOLS tab.

3. Either press Ctrl+O, or click Tear Out.
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4. Select Standard or Ripped Edge, depending on the effect you want.

5. Drag across the exhibit. When you release the mouse, the tear out displays on top of
the presentation.

To close the tear out, double-click it.

To manipulate a tear out

1. Select the tear out tool and then drag across the exhibit. 

2.  A tear out window opens.

To do this
to the tear
out:

Perform these steps:

Resize

1. Move the mouse to the lower right or lower left corner of the tear out
until the cursor changes to the resize cursor. 

2. Drag to resize the tear out.

Move

1. Move the mouse to the top of the tear out window.

A gray bar appears at the top of the tear out area.

2. Drag to move the tear out.

Close
Do either of the following:

Double-click anywhere in the tear out.
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Move the mouse to the upper right corner of the tear out and then click
the close window icon when it becomes visible.

Draw a
highlight

Once the tear out is open, drag across it to create a highlight. 

To access other annotation tools when a Tear Out is open

1. Right-click the tear out area on the screen.

The annotation gallery appears. 

2. Apply annotations as needed.

To set the default size, position, and border of tear outs

You can set the defaults for tear outs from the main window or from within the presentation
window.

1. Do either of the following: 

From the main window, on the FILE tab, click Options.

From the presentation window, click .

The Sanction Options dialog box opens.

2. Click Exhibits.

3. In the Tear Out Options area, adjust the default tear out size, position, and shape as
needed. 

Size can be set to between 50 to 100 percent. 

Position can be set to the top, center, or bottom of the screen.

Shape can be set to default, which is a smooth edge, or to a ripped edge.
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4. Click OK.

Related Topics

Annotation Layers

Annotating in Real Time

Text Clips

A text clip is a screen capture of a transcript segment, which is saved as an exhibit. 

The text clip can be added to a presentation to focus attention to an excerpt of a transcript.
You create a text clip from either an open transcript in the Transcript area or from within the
presentation window. 

Sanction saves text clips to the Exhibits > Images > Text Clips folder. 

Sanction puts text clips in Exhibit > Images > Text Clips

Text Clip options

When you create a text clip, you can select whether to include the name of the transcript
and/or the page and line range from where the text clip was drawn. These values can be
edited as needed. 

The screen shot below shows how the transcript title and page/line values look when
included in the text clip.
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A name and range can be added to the text clip

To create a text clip

1. Do one of the following: 

Click the Transcripts navigation bar and then select a transcript.

Open the transcript in the presentation window.

2. Select the text you want to use as a clip. 

3. Right-click the selected text and then click New Text Clip. Alternatively, if you are
working in the Transcripts area, on the New group, click Text Clip.

4. In the Create New Exhibit dialog, type a name for the clip.

5. If you want, you can add a name and range to the top of the text clip. 

Select Include Name to display the text as the top line of the text clip. You can edit
this field as necessary. By default, the value for this field is the file name of the
document. 

Select Include Range to display the page and line number range as the top line of the
text clip. 

Select both fields if you want the name followed by the range above the clip text.

6. Click OK.
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The clip is visible within the Exhibits folder, under the Images folder in Text Clips. 

To view text clips

1. Click the Exhibits navigation bar.

2. Expand the Exhibits tree and then expand Images.

3. Select the Text Clips folder. 

Text clips in the page list view

4. Select the clip you want to view.

The text clip is visible in the exhibit viewer.

Related Topics

Annotation Tools

Annotation Layers

Screen Captures

Video Stills

Adding and Removing Items

Video Stills

A video still is a single frame from a video, which is saved as an exhibit. 

You create a video still from an open video in the Media area or from a video open in the
presentation window. 

When you create a video still, Sanction puts it into the Exhibits > Images > Video Stills folder. 
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Sanction puts video stills in Exhibit > Images > Video Stills

To create a video still

1. Do one of the following:

In the main program window, click the Media navigation bar, and then select a video.

In the presentation window, open a video in the presentation.

2. Use the playback controls to move to the place in the video that you want to create a
still of.

3. On the media player, click the Video Still button or press Ctrl+Shift+V.



LexisNexis Sanction104

© 2019 LexisNexis. All rights reserved.

The video still button on the media player

4. In the Create New Exhibit dialog, type a name for the still and then click OK. 

The new video still is visible within the Exhibits folder, under the Images folder in Video
Stills. 

To view video stills

1. Click the Exhibits navigation bar.
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2. Expand the Exhibits tree and then expand Images. 

3. Select the Video Stills folder. 

The video still is visible in the page preview window.

Related Topics

Annotation Tools

Annotation Layers

Screen Captures

Adding and Removing Items

Wizards for Renaming, Renumbering, and Bates Numbering

Sanction provides wizards for renaming and renumbering exhibits, and for applying Bates
numbers to them. These wizards are accessible from the Info area of the FILE tab. They are
also available as a final, optional step when running the the exhibit import wizard. 
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Options for each wizard

Wizard Options

Alphanumeric

 

prefix and/or

suffix

Number

format

for zero

padding

Start

number

Period

separator

Comma

separator

Dash

separator

Number the

first page

Renaming*       

Renumbering

Exhibit numbers or trial

numbers.

     

Bates
numbering

    

* For multi-page exhibits, you can iterate the naming scheme on individual pages. You can
also set the exhibit name as the name of the first page.

To renumber exhibits and exhibit pages

1. On the FILE tab, click Info, and then click Rename & Renumber.

2. Click Rename Exhibits. 

The Welcome dialog box  for the Exhibit Renaming Wizard opens.

3. Click Next.

4. Select the folder that contains the exhibits you want to rename.

5. Move exhibits to the right column using the following options:

Select individual items and then click Add Selected.

Click Add All to select all items in the current folder.

If necessary, remove items from the right column, by selecting items there, and then
clicking Remove Selected or Remove All.   

6. Repeat the selection process on exhibits in other folders as needed until all the exhibits
you want to rename are listed in the right column.
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7. Click Next

The Order Exhibits dialog box opens. The position of exhibits in the list reflects the order
of the numerical sequence of the exhibit name.

8. Select items and then click Move Up or Move Down as needed to reposition exhibits in
the order you want, and then click Next.

The Naming Options dialog box  opens.

9. Select options as needed and then click Next. For more information on available options,
see the table at the start of this topic.

10. Review your selections. When ready, click Next.

The renaming process runs. When it finishes, a completion dialog box opens.

11. Click Close.

To update exhibit numbers or trial numbers

1. On the FILE tab, click Info, and then click Rename & Renumber.

2. Select Exhibit Numbering. 

The Welcome dialog box  for the Exhibit Renaming Wizard opens.

3. Click Next.

4. Select the folder that contains the exhibits you want to rename.

5. Move exhibits to the right column using the following options:

Select individual items and then click Add Selected.

Click Add All to select all items in the current folder.

If necessary, remove items from the right column, by selecting items there, and then
clicking Remove Selected or Remove All.   

6. Repeat the selection process on exhibits in other folders as needed until all the exhibits
you want to renumber are listed in the right column.

7. Click Next.

The Select Exhibit Numbers Field dialog box opens. 

8. Select Exhibit Numbers or Trial Numbers, depending on the property you want to
change, and then click Next. 
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9. Select items and then click Move Up or Move Down as needed to reposition exhibits in
the order you want, and then click Next.

The Exhibit Numbering Options dialog box  opens.

10. Select options as needed and then click Next. For more information on available options,
see the table at the start of this topic.

11. Review your selections. When ready. click Next.

The renumbering process runs. When it finishes, a completion dialog box opens.

12. Click Close.

To apply Bates numbering

1. On the FILE tab, click Info, and then click Rename & Renumber.

2. Select Bates Numbering. 

The Welcome dialog box  for the Exhibit Renaming Wizard opens.

3. Click Next.

4. Select the folder that contains the exhibits you want to apply Bates numbers to.

5. Move exhibits to the right column using the following options:

Select individual items and then click Add Selected.

Click Add All to select all items in the current folder.

If necessary, remove items from the right column, by selecting items there, and then
clicking Remove Selected or Remove All.   

6. Repeat the selection process on exhibits in other folders as needed until all the exhibits
you want to apply Bates numbers to are listed in the right column.

7. Click Next.

The Order Exhibits dialog box opens. 

8. Select items and then click Move Up or Move Down as needed to reposition exhibits in
the order you want, and then click Next.

The Bates Numbering Options dialog box opens.

9. Select options as needed and then click Next. For more information on available options,
see the table at the start of this topic.
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10. Review your selections. When ready, click Next.

11. The renaming process runs. When it finishes, a completion dialog box opens.

12. Click Close.

Related Topics

Importing Exhibits

Editing Item Properties

Zoom and Page View Settings

You can adjust the page view in the exhibit viewer by either zooming in on an image, or by
setting the layout of the page to one of several preset views.

To zoom in or out

1. Select the exhibit page you want to zoom in on.

2. Do one of the following:

On the IMAGE TOOLS tab, in the Tools group, click Crop Zoom or press Ctrl+M. Then
select the area on the exhibit you want to zoom to. To return to the original view,
double click anywhere within the zoomed region. 

 

On the bottom right of the exhibit viewer screen, move the slider to zoom in or out to
zoom as needed.

If you zoom in, you might need to re-center the image by using the scroll bars of the
exhibit viewer.

To set the view using presets

1. Select the Exhibits navigation bar. 

2. Select the exhibit you want to adjust the view on. 
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3. On the bottom right of the exhibit viewer screen, select one of the preset views next to
the slider.

These are the preset view options:

Fit to page. The entire page view is scaled to the viewing window. .

Fit to width. The page view is scaled so that the entire width of the page is visible in the
viewing window. This view can be helpful when you want to more easily read the text of
a letter- or legal-sized document

Fit to height. The page view is scaled so that the entire page can be seen in the viewing
window. For wider documents, this view might require that you scroll left and right to
view page content located toward the left and right margin of the page. 

Actual size. The page view is not scaled. If the exhibit is larger than the viewing
window, you will need to use scroll bars to see any page content outside the viewing
window. 

Related Topics

Annotation Layers

Tear Out Tool

Annotating in Real Time

Media

Importing Media

You can import video and audio files into your case. 

There are two ways to import media. You can either drag and drop folders and files directly into
a folder in the Media area, or you can run the Media Import Wizard, which is available from FILE
> Info > Import or from HOME > Import. 

If you import folders of media items, Sanction creates new folders in the Media tree that mirror
those you import.

To import media items by using drag and drop
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1. With a case open, click the Media navigation bar.

The Media folders are listed.

2. Drag and drop files or folders into any folder in the Media tree, except Playlists. 

A dialog box confirms the file import by providing a count of the number of files that were
imported and notes if any files could not be imported.  

3. Click Close to finish the import.

To import media by using the import wizard

1. Do one of the following:

Press Ctrl+I.

On the FILE tab, click Info, click Import, and then click Media. 

On the HOME tab, click Import. and then click Media. 

The Media File Import Wizard starts.
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2. Click Next. 

The Select Files to Import dialog box opens.
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3. Depending on whether you want to add files individually or by the folder, do one of the
following:

Click Add Files to add files individually. 

On the Select Files to Import dialog box, browse to the folder that contains the files,
select the files, and then click Open.

or

Click Add Folder to add an entire folder and its contents.

Browse to the folder location, select the folder, and then click Select Folder.

Repeat the steps as needed to add more files.

To remove one or more files, select the file(s) and then click Remove Files. To remove all
files, click Remove All.

4. Click Next.

The Select Import Destination Folder dialog box opens.
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5. Select a destination folder and then click Next. If necessary, you can click New Folder
and then create a new folder as a destination for the import.

The Ready to Import dialog box opens.
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6. Review the summary of your import selections. If the file list and destination folder are all
right, then click Next. 

The import proceeds. When completed, the Import Confirmation dialog opens. It provides
a count of the number of transcripts that were imported. Any error that occurred during
import is noted on the Import Confirmation screen. 
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7. Click Close.

Related Topics

Import Overview

Import Exhibits

Import Transcripts

Moving Exhibits and Media

Preferred Media Paths 

Adding and Removing Items

Media Clips

You can create a clip from an audio file, video file, or from a video deposition. Once a clip is
created, it is ready to be added to a playlist or it can be added to a presentation directly. To
create a clip, you use the media player and the clip creator.  These tools become available
whenever you select a video, audio item, synchronized transcript, or clip.

 

You can also create clips by selecting lines from a video deposition. For more information, see: 
Synchronized Transcripts.
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Media player w ith Clip Creator

Clips may be made from video transcripts by importing a clip list. A clip list is a text file that you
can create with Notepad or other plain text editor. The list identifies page and line numbers of
the transcript where you want clips to start and end. For more information, see: 

To create a media clip from an audio or video file

1. On the HOME tab, click the Media navigation bar.
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2. Select an audio or video file from the media list.

The media player opens in the preview window.

3. Use the play/pause button, and the slider on the media player to move to where you
want your clip to start.

4. Click Set Clip Start. 

5. Use the play button and the slider on the media player to move to where you want your
clip to end.

6. Click Set Clip End.

If necessary you can precisely edit the start and stop times. For more information, see
the next procedure in this topic.

7. Type a name for the clip, add a description, then click Save.
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The clip is now listed in the media clip list for that media item. From here, the clip may be
added to presentations directly or combined with other clips into playlists. For more
information on adding clips to a presentations, see: Add and Remove Items. For more
information on creating playlists, see: Playlists. You can also return to the clip anytime to
adjust its timing, rename it, or delete it.

To precisely edit the timing of a clip

You can precisely adjust the start and stop time of clips. This can be done either at the time
you are creating clips or later, after they are saved.

1. Select the clip you want to edit. 

2. Cue playback to begin a few seconds before the desired start time or end time.

3. Refine the start and stop times by using the tools described in the following table.

4. When you have cued playback to exactly where you want the clip to start or end, click
the Set Clip Start or Set Clip End button.

5. Click Save. 

Tools

Click  to start playing the clip again from the start.

Click  to start playing the clip 3 seconds before the end of the clip.

Depending on whether you want to change the start or the end time, perform the
following mouse operations on the start time field or the end time  field: 

Click the left mouse button on the field to move the time back 1 second, or press Shift
+left-click to move the time back 1/10th of a second. 



LexisNexis Sanction120

© 2019 LexisNexis. All rights reserved.

Click the right mouse button on the field to advance the time 1 second, or press Shift
+right-click to advance the start time 1/10th of a second. 

Note that these actions cause playback to immediately resume.

To preview a media clip

1. On the HOME tab, click the Media navigation bar. 

2. Select the media item that has the clip you want to preview. 

3. In the clip list, click the clip you want preview.

4. In the media player, click the play button. 

To rename or edit the properties of a clip

1. On the HOME tab, click the Media navigation bar.  

2. Select the media item that has the clip you want to rename or edit. 

3. In the clip list, do one of the following:

To do this: Perform these steps

Rename the clip

1. Do either of the following: 

On the ribbon, in the Actions group, click Rename.

Right-click the clip, and then click Rename.

2. Type the new name, and then press Enter.

Rename the clip or edit its
properties

1. Do either of the following: 

On the ribbon, in the Actions group, click Edit.

Right-click the clip, and then click Edit.

The clip properties dialog box opens. 

2. Edit properties as necessary then click OK.

To add clips to a playlist or presentation
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1. On the HOME tab, click the Media navigation bar. 

2. Select the media item that has the clip you want to add to a presentation or playlist. 

3. In the clip list, select the clips you want to add to a presentation or playlist. 

4. Select from among the following options:

To do this: Follow these steps:

Add clips to a
presentation

Do one of the following:

On the ribbon in the Add to group, click Presentation, and then
select the presentation you want to add the clips to. 

Right-click the clip selection, click Add to Presentation, and then
select the presentation you want to add the clips to. 

Add clips to a
playlist

Do one of the following:

On the ribbon in the Add to group, click Playlist, and then select the
playlist you want to add the clips to. 

Right-click the selected clips, click Add to Playlist, and then select
the playlist you want to add the clips to. 

Related Topics

Importing Media

Media Playback

Adding and Removing Items

Playlists

You can use playlists to present multiple media items and clips back-to-back without any pause
between them.

The process of creating playlists

At a high level, the process of creating playlists involves the following steps:

1. Create media clips from media items. For more information on creating media clips, see:
Media Clips.

2. Create the playlist. There are several ways to create playlists. These ways are described
in other procedures in this topic.

3. Add the media clips to the playlist. 

4. Edit the playlist as needed. This can mean doing any of the following:

Change the sequence in which clips are played.

Remove or add clips.
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Change the name of the playlist.

Add or edit the playlist description.  

These actions are described in this topic.

5. Add the playlist to a presentation. For more information on adding playlists and other
items to a presentation, see: Adding and Removing Items.  

To create a playlist via Playlist folder

1. Click the Media navigation bar.

2. Click the Playlist folder. 

3. On the HOME tab, in the New group, click New Playlist.

4. Type a name for the playlist and then click OK.

The new playlist is created in the Playlist folder. 

To create a playlist via clip selection

1. Click the Media navigation bar.
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2. Browse to the media item that has clips you want to start a new playlist from. 

3. Select the clips you want to create a playlist from. 

You can use Ctrl+click or Shift+click to select multiple clips

4. Do one of the following:

Right-click a selected clip, click Add to Playlist, and then click New Playlist.

On the HOME tab, in the Add To group, click Playlist. and then click New Playlist.

5. Type a name for the playlist and then click OK. 

The new playlist is created. Click the Playlist folder to see your new playlist. 
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To add clips to a playlist

1. Click the Media navigation bar. 

2. Browse through the media folders to select the media item that has the clip you want to
add to the playlist. For information about creating media clips, see: Media Clips.

3. In the clip list area of the workspace, select the clip you want to add to the playlist.
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4. Do one of the following:

Right-click the selected clips, click Add to Playlist, and then select an existing playlist or
create a new one.

On the HOME tab, in the Add To group, click Playlist, and then select an existing playlist or
click New Playlist to add the clip to a new playlist.

The clip is added to the playlist.

To change the presentation sequence of clips

1. Select the Media navigation bar.

2. Select the Playlist bar and then select the playlist you want to change the clips for.

3. Select the clip that you want to change the sequence for and then do one of the
following:
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On the HOME tab, in the Actions group, click Move Up or Move Down, depending on
where you want to move the clip.

Right-click the clip, and then click Move Up or Move Down, depending on where you
want to move the clip. 

To rename or add a comment to a playlist

1. Click the Media navigation bar.

2. Click the Playlist folder.
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3. Follow steps as indicated in the following table:

To accomplish this: Do this:

Rename the playlist Right-click the playlist, click Rename, type the new name, and
then press Enter.

Rename or add a
comment to the playlist

Right-click the playlist, click Edit, type a new name, and/or add
a comment, and then click OK. 

To remove media clips from a playlist

1. Click the Media navigation bar. 

2. Click the Playlist folder.
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3. Select the playlist you want to remove the clip from. 

4. In the clip list, select the clips you want to remove from the playlist.

5. Do one of the following:

On the HOME tab, in the Actions group, click Remove Item.

Right-click the clip, and then click Remove Item. 
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The clip is removed from the playlist.

To delete a playlist

1. Select the Media navigation bar.

2. Select the Playlist button. 

3. Select the playlist you want to delete. 

4. Do one of the following:

Press Ctrl+D.

On the HOME tab, in the Actions group, click Delete.

Right-click the playlist and then click Delete. 

The playlist is deleted and removed from presentations. However, the clips which
comprised the playlist are not deleted and can still be used in other playlists.

To add a playlist to a presentation from the main program window

1. Select the Media navigation bar.

2. Select the Playlist button. 

3. Select the playlist you want to add to a presentation. 

4. Do one of the following:

On the HOME tab, in the Add To group, click Presentation and then select an existing
presentation or click New Presentation to create a new one.
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Right-click the playlist, click Add to Presentation, and then select an existing
presentation or click New Presentation to create a new one.

On the HOME tab, in the Present group, click Show Item. The playlist opens in the
presentation window and is added to the current presentation.  

To add a playlist to a presentation from the presentation window

From the presentation window, type the name of the playlist and then press Enter.

The playlist opens in the presentation window and is added to the end of the
presentation.

Related Topics

Media Clips

Adding and Removing Items

Preferred Media Paths

A preferred media path is a folder location on your computer that is registered in a Sanction
case. Sanction uses these paths to find media, the video for synchronized transcripts, and
playlists. 

By default, the Media folder within the case folder on the computer's file system is registered as
a path. 

When you import media, a new preferred media path is added to your case, which points to
source folder for the media. Also, during the import process, you can optionally specify that all
subfolders be added as preferred media paths. 

Sanction will also register a preferred media path to the Transcripts folder if you import a
synchronized transcript to the Transcripts folder. These paths are editable.

Note that merely copying media files to a preferred media path folder does not make them
immediately visible from within the case. For a case to be visible, it must be imported. For more
information on importing media, see: Importing Media.

You can manually add, edit or delete preferred media paths by doing any of the following:

On the FILE tab, click Info, and then click Media Paths.

In the main program window, at the top of the folder list, right-click the case name and
then click Preferred Media Paths.

When importing transcripts, as of the last steps in the transcript import wizard, you can
open the preferred media paths dialog box. You would normally use this method if the
video for a synchronized transcript was kept in a folder other than the Transcripts folder.  
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Note the following considerations:

If you move media to a folder location that is not registered as a preferred media path, you
must add a preferred media path to the new media location. For more information on
moving cases and media see: Moving Cases and Media Files.

When you try to play media that Sanction is unable to find, error conditions occur. For more
information, see: Managing issues with media playback.

If you receive this error message: Media File Not Found, it means that a preferred media
path has not been established to the media you are attempting to play. This condition can
be the result of importing a synchronized transcript without also having established a
media path to the video portion of the transcript. 

To rectify this situation, you can do any of the following:

Use the Media Import Wizard to re-import the audio or video. For more information,
see: Importing Media.

Copy the media file to the Media folder in the case folder on the Windows file
system. You can determine the folder location on the Windows file system. To do so,
on the FILE tab, click Info. The folder path is provided in the Case Directory field.

Manually establish a preferred media path to the media file, which is described in this
topic.

For more information, see: Managing issues with media playback.

To manually add, edit, or delete a preferred media path

1. Open the case that you want to change the path for. 

2. Do either of the following:

Select the FILE tab, click Case Media Paths, and then click Add. 

Select the HOME tab, in the task column heading, right-click the case name, and then
click Preferred Media Paths.
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3. Select an option. 

Option Steps

Add a new path.

Do one of the following:

Type the path and then click OK. 

Click Browse, select the updated folder, click Select Folder,
and then click OK.

Edit an existing
path.

Select the path you want to edit, and then do one of the
following:

Type the new path over the existing one and then click OK.

Click Browse, select the updated folder, click Select Folder,
and then click OK.

Note that when adding a new path or editing an existing one, if you want Sanction to
automatically include all folders under a selected path, then click Include Subfolders.

Delete a path. Select the path and then click Delete.

4. Click OK. 

You are returned to the Case Properties dialog box.

5. Click OK.

To change the order of preferred media paths
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1. Open the case. 

2. Do either of the following:

Select the FILE tab, click Case Media Paths, and then click Add. 

Select the HOME tab, in the task column heading, right-click the case name, and then
click Preferred Media Paths.

o

3. Select a media path and then click Move Up or Move Down as needed to reposition it in
the list. Repeat this step with any other media path that you want to reposition.

4. Click OK. 

To add a path when importing transcripts

1. Start the process of importing transcripts into your case by doing either of the following:

On the FILE tab, in the Info area, click Import, and then click Transcripts.

On the HOME tab, click Import, and then click Transcripts.

2. Proceed with running the wizard to import transcripts, until the Import Confirmation
step. 
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3. In the Import Confirmation dialog box, click Select Media Paths.

4. Click Add, and then click the folder that has media for your case in it. 

Select Include Subfolders if you want Sanction to find media in any folders within the
folder you selected.

5. Click OK.                                                                  

Related Topics

Importing Media

Copy Video Files to the Case Media Folder

You can use Sanction to copy all the video files for your case to the Media folder for the case.
Media files are copied from each preferred media path registered for the case. Copying all the
media files to the local media folder can help to ensure that if you move your case, the video
files will be moved along with the case.

To copy video files to the case media folder

1. On the FILE tab, in the Info area, click Copy Video Files.

 The Copy Video Files wizard starts.

2. Click Next.

3. Navigate to videos you want to copy to the case media folder for your case and then do
the following:

Click Add All to copy all the files in the selected folder.

Click Add Selected to copy just the selected videos.

Click Remove Selected to remove a video from the selection list.

Click Remove All to clear the selection list.

4. When the selection list has the files you want to move, click Next.

5. In the Ready page of the wizard, verify the list of files you want to copy and the folder
path to the Media folder for the case. 

6. Click Next.
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7.  In the confirmation screen, click Close.              

Related Topics

Importing Media

Video Stills

A video still is a single frame from a video, which is saved as an exhibit. 

You create a video still from an open video in the Media area or from a video open in the
presentation window. 

When you create a video still, Sanction puts it into the Exhibits > Images > Video Stills folder. 

Sanction puts video stills in Exhibit > Images > Video Stills

To create a video still

1. Do one of the following:

In the main program window, click the Media navigation bar, and then select a video.

In the presentation window, open a video in the presentation.

2. Use the playback controls to move to the place in the video that you want to create a
still of.

3. On the media player, click the Video Still button or press Ctrl+Shift+V.
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The video still button on the media player

4. In the Create New Exhibit dialog, type a name for the still and then click OK. 

The new video still is visible within the Exhibits folder, under the Images folder in Video
Stills. 

To view video stills

1. Click the Exhibits navigation bar.
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2. Expand the Exhibits tree and then expand Images. 

3. Select the Video Stills folder. 

The video still is visible in the page preview window.

Related Topics

Annotation Tools

Annotation Layers

Screen Captures

Adding and Removing Items

Transcripts

About Transcripts

You can import transcripts, including synchronized transcripts into your case. 

After importing synchronized transcripts into your case, Sanction provides a way to easily
navigate and manage transcript tasks.
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You can also create individual clips from the same synchronized transcript by using a clip list. 

Benefits of importing synchronized transcripts into your case include:

Management of media clips via Transcript Synchronization

Adding a new clip

Editing existing clips

Export clip lists

Synchronize text and video files

Export synchronized packages in various formats 

If you have multiple media clips, you can undock your cliplist and media library into a separate

window by clicking the undock control button  in the media pane. This allows you to see

more clips at a time. 
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Click the dock control button  to place the pane back to its original location.

The pane immediately goes back to its original location when you navigate to another tab.

Related Topics
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Importing Transcripts

Synchronized Transcripts

Synchronizing Text and Video Files

Clip Lists for Synchronized Transcripts

Text Clips

Set Transcript Viewer Options

Importing Transcripts

You can import transcripts into your case. 

There are two ways to import transcripts into your case. You can either drag and drop
transcripts directly into the transcripts list, or you can run the Transcripts Import Wizard, which
is available from FILE > Info > Import or from HOME > Import.

To import exhibits by using drag and drop

1. With a case open, click the Transcripts navigation bar.

2. Drag and drop transcripts individually or by the folder to the list area just above the
navigation bars.  
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A dialog box confirms the file import by providing a count of the number of transcripts
that were imported and notes if any were skipped. 

3. Click Close.

To import transcripts by using the import wizard

1. With a case open, do one of the following:

Press Ctrl+I.

On the FILE tab, click Info, click Import, and then click Transcripts. 

On the HOME tab, click Import. and then click Transcripts.

The Transcript File Import Wizard opens.

2. Click Next.

The Select Transcript Files to Import dialog box opens. 

3. Click Add Files and then browse to the folder where the transcripts are located. Select
the transcripts you want to import and then click Open. The transcripts you selected are
listed in the dialog box. 

Repeat this step as needed to select more transcripts.

To remove one or more files, select the file(s) and then click Remove Files. To remove all
files, click Remove All.

4. Click Next.

The Ready to Import dialog box opens.
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5. Click Next.

The selected transcripts are imported and the Import Confirmation dialog opens
displaying a count of imported transcripts. 

6.  Do one of the following: 

For this condition: Perform these steps:

None of the transcripts
you imported were
synchronized
transcripts.

Click Close. 

One or more of the
transcripts you
imported are
synchronized
transcripts.

AND 

The media files for the
synchronized
transcripts have not
been added to the
Media folder for the
case in the Windows
file system.

1. Click Select Media Paths. The Case Media Paths dialog box
opens.

2. Review the list of paths. 

3. Add paths as needed to make sure each media file can be
reached along a path.

o If a path already exists to a folder that is positioned
higher in the file system hierarchy than the folder that
contains transcript media, then click Edit, click Include
Subfolders, and then click OK.

4. When finished adding paths, click OK to finish working in
the Case Media Paths dialog box.

5. Click Close to complete the Transcript File Import Wizard.

Duplicates are
imported. 

1. Click Rename Duplicates.

2. Click Close if you choose to not rename the duplicate files.

3. The files are added to the case in the folder you selected.

4. If you choose the option to Rename Duplicates, the Rename
Duplicates dialog box opens and shows a list of the
duplicate files imported. 

5. To rename the duplicates, double-click the file name.

You can also press F2 to rename the file. 

6. After you have renamed your duplicates, click Finish. 

         

Related Topics

Import Overview

Import Exhibits

Import Media

Preferred Media Paths
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Synchronized Transcripts

Synchronizing Text and Video Files

Synchronized Transcripts

After importing synchronized transcripts into your case, Sanction provides a way to easily
navigate and manage transcript tasks.

You can easily navigate between the following panes:

Transcript synchronization

Add a New Clip

Edit Existing Clips



LexisNexis Sanction144

© 2019 LexisNexis. All rights reserved.

When you move from one tab to another, the last clip you worked on is selected. If no
work has been done in the pane, nothing is selected. All tasks are kept separate from
another. 
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You can work with synchronized transcripts in the following ways to enrich presentations:

Add and clear timestamps as well as jump to specific locations in the media file in the
transcript. 

Add information about editing clip properties as well as transcript properties.

Add them directly into presentations. There are several methods for accomplishing this. A
common way to add synchronized transcripts is described in Adding and Removing Items.
Other methods, more typically used to add synchronized transcripts during presentations.
are described in Using the Show Item Command, and in Controlling Item Presentation. 

Create media clips with synchronized text playback. 

Add media clips taken from synchronized transcripts to playlists and presentations. 

Hide or show the synchronized text in presentations. If you choose to show synchronized
text, you can specify its position on screen, font characteristics, the number of lines to
display, and highlighting options. You can also modify the timing, name, and other
properties of the clips you create from transcripts.

Create text clips and video stills. For more information, see: Text Clips and Video Stills.

Working with synchronized transcripts

Sanction provides a built-in tool to search for clips, manage playback speed, and to manage
timestamps. 

To search clips

You can search, filter and navigate existing clips to find specific clip information. 

1. On the HOME tab, click the Transcripts navigation bar.

2. On the Transcript Synchronization tab, enter a term in the clip list search box. 

3. Click the magnifying glass in the search box. 

A list of result(s) of your search term is displayed. 

You can sort and navigate the clips by doing the following:

Filter by clip name

Filter by clip description

Navigate to the next hit by using the mouse or the up and down arrows

Managing playback speed

Playback speed can be managed from all three tabs when working with synchronized
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transcripts by clicking the  button.

The following playback speed options are available:

.5 speed

1 x speed

1.5 x speed

2 x speed

Managing timestamps

You can adjust timestamps in synchronized transcripts to prepare for video presentation.

Timestamps can be removed and added. You can also jump to a specific line in the
transcript.

To remove timestamps

1. Click the Clear all timestamps button.

2. When the warning message appears to remove the timestamps, click OK.

The timestamps are removed from the transcript.

Once the timestamps have been removed, the clip(s) will need to be synchronized
to the text once the timestamps have been reapplied. 

To add a timestamp/sync transcript with video

1. Select the location in the text transcript to begin timestamping.

2. Set the video to the same location.

3. Click the Add timestamp button.

You can also press the spacebar.

4. Play the video.

5. Click the Add timestamp button when the first word of each new line is spoken.

You can also press the spacebar to add the timestamp. 

To jump to a specific location in your media file

You can quickly jump to a specific location in your transcript that has timestamps
applied. 

The transcript has to be partially or fully timestamped to use the “Jump to” feature.

1. On the Transcript Synchronization pane, click the Jump to button.
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The text associated with the timestamp is highlighted.

2. If there is no timestamp associated, you can begin timestamping the remainder of
the video. Do one of the following:

Click Yes to begin timestamping from the last location

Click No to continue viewing the video at the last selected location 

To add a new media clip from a synchronized transcript

You can create individual clips in your synchronized transcript. This allows you to set the
start and end times for a clip(s).

It is also possible to create multiple clips at a time by importing a clip list file. For more
information on creating and importing clip list files, see: Clip Lists for Synchronized
Transcripts.

1. On the HOME tab, click the Transcripts navigation bar. 

2. Select the synchronized transcript that you want to create a clip from.

The media player and clip creator open next to the transcript.

3. Specify the start and stop times of the clip from the Add a New Clip tab by using one of
the following methods:
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Method Steps

By selecting
transcript text

1. Select the lines of transcript that you want in the clip. 

2. Right-click the selection and then click New Media Clip.  

The media player starts playing the video at the start of the
selection and pauses playback when the end of the selection is
reached. The Start and Stop times are also populated accordingly. 

3. Type a name for your clip. Note that the description field is auto-
populated with the page and line numbers of the clip. 

4. Edit the description as necessary and then click Save.

The clip is visible in the media clip list.

By typing the
page and line
numbers
(Quick Clip)

1. Type the page and line range of the clip into the Quick Clip field and
then press Enter.

The Start- and End time of the page and line range are populated in
their respective fields. The Description field is populated with the
Page and line range. 

2. If necessary, you can more precisely adjust the timing of your clip.
For more information see the procedure To precisely edit the timing
of a clip in this topic.

3. Type a name for the clip, and optionally, edit the clip description, and
then click Save.

The clip is visible in the media clip list.

You can use any of the following formats to indicate the page/line
range for the clip:

Pg.Ln+Pg.Ln
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Pg:Ln+Pn:Ln
Pg.Ln-Pg.Ln
Pg:Ln-Pg:Ln

For example, 4:14-4:17 starts the clip on page 4, line 14 and ends it
on page 4, line 17.

By using the
play button
and the media
slider 

Use the play button and media slider to move to set the Start and
End times. 

1. Move the slider to the desired position or play the video and click the

Clip icon  to set the Start time. 

2. Move the slider to the end point of the clip or continue to play the

video and click the Clip icon  to set the End time.

3. The Start- and End time of the page and line range are populated in
their respective fields. The Description field is populated with the
Page and line range. 

1. Type a name for the clip, and optionally, edit the clip description, and
then click Save.

The clip is visible in the media clip list.

To precisely edit the timing of a clip

As you create a new clip or edit an existing clip, you can precisely adjust the start or end of
the clip. 

The method of accomplishing this is to begin playing the clip at a position slightly ahead of
the desired start time or end time. Then, as playback proceeds, you click the left right or
mouse buttons at the exact position where you want the clip to start or end. 

1. Click  to start playing the clip again from the start.

2. Click the  to start playing the clip 3 seconds before the end of the clip.
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3. Depending on whether you want to change the start or the end time, perform the
following mouse operations on the start time field or the end time  field: 

Click the left mouse button on the field to move the time back 1 second, or press Shift
+click to move the time back 1/10th of a second. 

Click the right mouse button on the field to advance the time 1 second, or press Shift
+right click to advance the start time 1/10th of a second. 

Note that these actions cause playback to immediately resume.

4. Click OK to save changes or Click Cancel if you do not want to save the changes. 

You can view the instructions on how to edit a clip within application by clicking the link
beside Clip Information.

To add clips from a synchronized transcript to a playlist or presentation

1. On the HOME tab, click the Transcripts navigation bar. 

2. Select the transcript that has the clip you want to add to a presentation or playlist. 

3. In the clip list, select the clips you want to add to a presentation or playlist. 

4. Select from one of the following options:

To do this: Follow these steps:

Add clips to a
presentation

Do one of the following:

On the ribbon in the Add To group, click Presentation, and
then select the presentation you want to add the clips to. 

Right-click the clip selection, click Add to Presentation, and
then select the presentation you want to add the clips to or
add to a new presentation.  

Add clips to a playlist

Do one of the following:

On the ribbon in the Add to group, select Playlist, and then
select the playlist you want to add the clips to. 

Right-click the selected clips, click Add to Playlist, and then
select the playlist you want to add the clips to or add to a
new playlist. 

To preview a synchronized transcript clip

1. On the HOME tab, click the Transcripts navigation bar. 
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2. Select the transcript that has the clip you want to preview. 

3. In the clip list, do one of the following:

Double-click the clip.

Select the clip you want preview and then click the play button on the media player.

The clip video plays in the media viewer. 

To rename or edit the properties of a clip

1. On the HOME tab, click the Transcripts navigation bar.  

2. Select the synchronized transcript that has the clip you want to rename or edit. 

3. In the clip list, follow steps of the changes you want to make:

Action Steps

Rename the clip 1. Do either of the following: 

On the ribbon, in the Actions group, click Rename.

Right-click the clip, and then click Rename.

2. Type the new name, and then press Enter.

Edit clip properties 1. Do either of the following: 

On the ribbon, in the Actions group, click Edit.

Right-click the clip, and then click Edit.

The clip properties dialog box opens. 

2. Edit properties as necessary then click OK.

To rename or edit the properties of a synchronized transcript

You can edit the first and last pages (bookmark), as well as rename and edit additional
properties of a synchronized transcript.
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1. On the HOME tab, click the Transcripts navigation bar.

2. Select the synchronized transcript that you want to rename or edit.

3. Follow the steps of the changes you want to make: 

Action Steps

Rename the
transcript

1. Do either of the following: 

On the ribbon, in the Actions group, click Rename.

Right-click the selected transcript, and then click Rename.

2. Type the new name, and then press Enter.

Edit clip properties 1. Do either of the following: 

On the ribbon, in the Actions group, click Edit.

Right-click the selected transcript, and then click Edit.

The clip properties dialog box opens. 

2. Edit properties as necessary then click OK.

To set presentation options for synchronized transcripts
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1. Open the Sanction Options dialog box using either of the following methods:

To
configure
options
from this
window:

Follow these steps:

Main
program
window

On the FILE tab, click Options.

Presentation
window

In the presentation window, select the presentation options icon.

 

2. Click Presentations, and then scroll down to the Synchronized Text section of the dialog
box.
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3. Configure options as needed. These are described as follows:

Main option Description

Synchronized
Text

Select this option to show synchronized text in the item window. Text
appears below the media player. 

Lines to Display controls the number of lines of text that are
shown. The number can range from 1 to 10.

Synchronized Line specifies the line that holds the currently
playing text.

Lines to Highlight specifies the number of lines to highlight.

Font Settings specify the font, size and color of the text.

Background Color specifies the background of the text field that
displays the synchronized text.

Highlight Color specifies the color that is applied to the currently
playing line of transcript.

Synchronized
Text As Overlay

Select this option to overlay synchronized text  on top of the media
player.

Font Settings specify the font, size, color, background color and
opacity of the text.

Hide
Synchronized
Text

Select this option to hide synchronized text so that it does not appear
at all.

4. Click OK.

Related Topics

Importing Transcripts

Synchronized Transcripts

Synchronizing Text and Video Files

Importing/Exporting clip lists

Text Clips

Text Clips

Media Clips

Media Playback

Adding and Removing Items

Synchronizing Text and Video Files

You can easily synchronize associated text and video files via the Transcript Synchronization
Wizard.

This feature allows you to partially or fully synchronize the transcript as well as add
timestamps. 
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To synchronize, the text file transcript and video must already be imported into Sanction.
See Import Overview for more information. 

To synchronize text and video files

1. On the HOME tab, click the Transcripts navigation bar.

2. Select the transcript that you want to synchronize.

3. Do one of the following:

On the ribbon, in the Actions group, click Synchronize Transcript. Then click Manually
Synchronize. 

Right-click the selected transcript, and click Synchronize Transcript. Then click
Manually Synchronize.

4. The Transcript Synchronization Wizard dialog box opens, click Next.

5. Click the folder that contains the video or audio clips that you want to export.

6. Do either of the following, depending on what you want to export: 

Click Add All to add all the listed items.

Select individual files or folders and then click Add Selected. 

After adding items, you can remove them as needed from the queue. To remove one or
more items, CTRL+click or SHIFT+click items and then click Remove Selected. To
remove all items, click Remove All.

Items are listed in the right panel of the dialog box.

7. Click Next. 

8. Click Move Up or Move Down to set the order of the media files and then click Next.

9. Confirm the imported files on the Import Confirmation screen and then click Close. 

To send files to vTestify

1. On the HOME tab, click the Transcripts navigation bar.

2. Select the transcript that you want to send to vTestify.

3. Do one of the following: 

On the ribbon, in the Actions group, click Synchronize Transcript. Then click Manually
Synchronize. 

Right-click the selected transcript, and click Synchronize Transcript. Then click
Manually Synchronize.

4.  The DepoSync vTestify page opens. Type the necessary information on the Deposync
Request form; check the I’m not a robot checkbox.

5.  Click Submit Order. 
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  To add a timestamp/sync transcript with video

1. Select the location in the text transcript to begin timestamping.

2. Set the video to the same location.

3. Click the Add timestamp button.

You can also press the spacebar.

4. Play the video.

5. Click the Add timestamp button when the first word of each new line is spoken.

You can also press the spacebar to add the timestamp. 

Related Topics

Importing Transcripts

Synchronized Transcripts

Clip Lists for Synchronized Transcripts

Text Clips

Set Transcript Viewer Options

Importing/Exporting clip lists

If you need to create many individual clips from the same synchronized transcript, using a clip
list can save you time when compared to typing each clip individually into the Quick Clip field of
the media player. 

A clip list is a plain text file that contains a list of the clips that you want to create from a
synchronized transcript. You can create a clip list by using any text editor, such as Notepad.
After you create a clip list file, you can use Sanction to import it, which will create the clips. 

You can also export clip lists to a csv file via the Clip List Export Wizard. 

To create the clip list file

1. Read over the transcript to identify the page and line numbers where you want each clip
to start and end.

2. Open a plain text editor, such as Notepad.

3. For each clip you want to create, type the page and line number for the start of the clip
followed by the page and line number for the end of the clip, using the following format:

Pg:Ln-Pg:Ln

For example, the following would create 2 individual clips: 

4:14-4:17
5:2-6:20
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The first clip would start on page 4, line 14 and end on page 4, line 17. The second
clip would start on page 5, line 2, and end on page 6, line 20.

4. After each page and line range add a hard return. 

5. Save the file.

6. Use Sanction to import the file. The import process is described in the next procedure of
this topic.

Any of following formats may be used to designate ranges for individual clips:
Pg.Ln+Pg.Ln
Pg:Ln+Pn:Ln
Pg.Ln-Pg.Ln
Pg:Ln-Pg:Ln

To import the clip list

1. On the HOME tab, click the Transcripts navigation bar.

2. Click the synchronized transcript that you want to create the clips for. 

Synchronized transcripts are marked with a film frame icon

3. On the HOME tab, click Import, and then click Clip List.

The Welcome to the Clip List Import Wizard dialog box opens.

1. Click Next.

The Select Clip List File to Import dialog box opens.

2. Click Add File.
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3. Navigate to the clip list file, select it, and then click Open.

The clips are listed in the Select Clip List to Import dialog box.

4. Click Next.

The Import Confirmation dialog box opens.  

5. Click Close.

The clips are created for the synchronized transcript and ready to use.

To export a clip list

You can share your work with your team by exporting a clip list to a csv file. 

1. On the HOME tab, click the Transcripts navigation bar.

2. Select the synchronized transcript from the transcript list.

3. On the HOME tab, click Export.

4. Click Clip List.

5. The Clip list Export Wizard dialog box opens, click Next.

6. Click the folder that contains the video or audio clips that you want to export.

7. Do either of the following, depending on what you want to export: 

Click Add All to add all the listed items.

Select individual files or folders and then click Add Selected. 

After adding items, you can remove them as needed from the queue. To remove one or
more items, CTRL+click or SHIFT+click items and then click Remove Selected. To
remove all items, click Remove All.

Items that are ready to be exported and are listed in the right panel of the dialog box.

8. Click Next. 

The Select the Destination file dialog box opens.

9. Click the Browse button to navigate to the location where you want the clip list(s) saved.

10. Type the file name, click Save and then click Next.

The default destination is now set for your clip list(s).

11. In the Ready to Export dialog box, verify your clip list selections before exporting and
then click Next.

The clip lists are exported to the destination folder. 

12. The Export Confirmation dialog box appears to confirm the number of clips successfully
imported. Click Close to close the wizard. 
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Related Topics

About Transcripts

Creating Text Clips

Creating Text Clips

A text clip is a screen capture of a transcript segment, which is saved as an exhibit. 

You create a text clip from either an open transcript in the Transcript area or from within the
presentation window. Sanction saves text clips to the Exhibits > Images > Text Clips folder. 

Text clips made from transcripts are added to the Text Clips folder

To create a text clip

1. Do one of the following: 

Click the Transcripts navigation bar and then select a transcript.

Open the transcript in the presentation window.

2. Select the text you want to use as a clip. 

3. Do one of the following: 

On the HOME tab, in the New group, click Text Clip.

Right-click the selected text and then click New Text Clip. 

4. In the Create new exhibit from text clip dialog box, type a name for the text clip.

5. If you want, you can add a name and range to the top of the text clip. 

Select Include Name to display the text as the top line of the text clip. You can edit
this field as necessary. By default, the value for this field is the file name of the
document. 

Select Include Range to display the page and line number range as the top line of the
text clip. 
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Select both fields if you want the name to appears as the top line, followed by the
range, and then the clip text.

A name and range can be added to the top of the text clip

6. Click OK.

The clip is visible within the Exhibits folder, under the Images folder in Text Clips. 

To view text clips

1. Click the Exhibits navigation bar.

2. Expand the Exhibits tree and then expand Images.

3. Select the Text Clips folder. 

Any video stills created for the case are visible in the page list view.

4. Select the clip you want to view.

The text clip is visible in the page preview window.

Related Topics

Screen Captures

Video Stills
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Adding and Removing Items

Set Transcript Viewer Options

You can set the font, font size, and highlight color for transcript text. On synchronized
transcripts, you can also show or hide the date stamp. 

To set transcript viewer options

You can set the defaults for the transcript viewer from the main window or from within the
presentation window.

1. Do either of the following: 

On the FILE tab, click Options.

From the presentation window, click .

The Sanction Options dialog box opens.

2. Click Transcripts.

3. Adjust transcript display settings as needed. 

Synchronized transcripts can show or hide a date stamp.

The highlight color for synchronized transcripts can also change. 

Transcript text font, size, and color can also be set.

4. Click OK.

For more information, see: Set Presentation Options.

Related Topics
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Screen Captures

Video Stills

Adding and Removing Items

Search

Finding and Replacing Case Items

Sanction allows you to edit data in your case using search and replace with a built-in Case
Editor. This feature allows you to easily make adjustments to the information in the
presentation by using find and replace.

You can find and replace items in your case by running searches based on the following item
properties:

Item name

Exhibit number

Trial number

Bates number

Description

Admit date or date range

Transcript date or date range

You can also search the text of a transcript. For more information, see: Searching Transcript
Text.

To find text/properties and dates

1. On the HOME tab, click Find and Replace.

 

2. Search for text or date using the options as needed.
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These options are listed as follows:

Search type Description of options

Search for
text and
properties

Available properties: 

Name

Exhibit Number

Trial Number

Bates Number

Description

Description Operators: 

Contains

Equals

Starts With

Ends With

Search by
date

Available date fields:

Admit date

Transcript date

Date types: 

Specific date
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On or before

On or after

3. Click Search. 

The search results are listed. 

4. Click one of the following: 

Double click the item to open. 

Click New Search, which opens the search dialog box again.

Click Close to close the Search for Sanction Case Items dialog box. 

To find and replace text/properties and dates

1. On the HOME tab, click Find and Replace.
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2. Click the Replace tab, and then search for text or date using the options as needed.

These options are listed as follows:

Search type Description of options

Search for
text and
properties

Available properties: 

Name

Exhibit Number

Trial Number

Bates Number

Description

Description Operators: 

Contains

Equals

Starts With

Ends With
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Search by
date

Available date fields:

Admit date

Transcript date

Date types: 

Specific date

On or before

On or after

3. In the Replace with field, type the information to replace the text or date. 

4. Click one of the following:

Replace to replace the information in the highlighted record.

Replace All to replace information in all records.

Find Next to go to the next record.

Click Cancel to close.  

5. Click Yes in the warning dialog box if you Replace All. 

6. Click Cancel close the Find and Replace dialog box.

Related Topics

Editing Item Properties

Wizards for Renaming, Renumbering, and Bates Numbering

Searching Transcript Text

Searching transcript text

You can search for a word in a transcript that is open in either the main program window or the
presentation window.

To search a transcript
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1. Do either of the following depending on whether you are working in the main program
window or the  presentation window.

2. In the main program window, on the HOME tab, click the Transcripts navigation bar, and
then slect the transcript you want to search.

3. In the presentation window, open the transcript you want to search. 

4. Click the search box, type a search term, and then press Enter.

5. Use the navigation buttons to move among search hits. 

Related Topics

Text Clips

Synchronized Transcripts

Searching for Case Items

Presentations

Create Presentations

Create a Presentation

You can create a new presentation either:

HOME > Presentations navigation bar > New Presentation.

Right-click a single-page exhibit, image, or page > New Presentation. 

Right-click a media item or clip > New Presentation.

A presentation name cannot contain any of the following characters:  / \ : * < > |

To create a presentation from the Presentations navigation bar

1. Click the Presentations navigation bar.
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2. On the HOME tab, click New Presentation or press Shift+Ctrl+N.

3. Type a new name for the presentation and then click OK.   

The new presentation appears in the presentation list.

To create a presentation by right-clicking an item

1. Click either the Exhibits navigation bar, the Media navigation bar, or the Transcripts
navigation bar.

2. Right-click any of the following kinds of items that you want to create a presentation
from:

Exhibit page or image

Media item

Media clip

Transcript

3. On the right-click context menu, click Add To Presentation, and then click New
Presentation. 
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4. Type a new name for the presentation and then click OK.   

The new presentation appears in the presentation list. 

To rename or delete a presentation

1. On the HOME tab the Presentations navigation bar.

2. Select the presentation you want to rename or delete. 

To do this: Perform these steps:

Rename the
presentatio

n

On the HOME tab, in the Actions group, click Rename, or right-click the
presentation and then click Rename. Type a new name for the
presentation and then click OK.   
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Delete the
presentatio

n

On the HOME tab, in the Actions group, click Delete, or right-click the
presentation and then click Delete. Click Yes in the confirmation dialog
box.

     

Related Topics

Adding and Removing Items

Adding or removing items

You can add items to presentations from the main program window or from the presentation
window. This topic focuses on how to add items from the main program window. To learn how
to add items while presenting, see: Adding Items During the Presentation. 

To add items to presentations from the main program window

1. Click the navigation bar that corresponds to the type of item you want to add to your
presentation. 

To add this type of item: Select this navigation bar:

An exhibit page

Image

Screen capture

Text clip of a transcript

Still image from a video

Time line image

Exhibits

Audio

Video

Media clip

Playlist

Media
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Plain text transcript

Synchronized transcript

Transcripts

2. Select the item that you want to add.

3. Do one of the following: 

On the HOME tab, in the Add To group, click Presentation, and then click the
presentation that you want to add the item to.

Right-click the item, click Add to Presentation, and then click the presentation that you
want to add the item to.

4. Optionally, to verify that the item was added to the presentation, click the Presentations
navigation bar and then select the presentation.  

Items that were added appear in the presentation item list. After you add items, you can
change their sequence in which they will appear in the presentation. For more
information, see: Changing Item Presentation Sequence.

To remove items from a presentation

1. On the HOME tab, click the Presentations navigation bar.

2. In the presentation list, click the presentation you want to remove items from. 

3. In the item list, select items you want to remove and then do one of the following:

Press Ctrl+Alt+R.

On the HOME tab, in the Actions group, click Remove Item.
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Right-click the items and then click Remove Item. 

The selected items are removed from the presentation. 

Never use the Delete command to remove an item from a presentation. Attempting
to do so will delete the entire presentation.

Related Topics

Annotating in Real Time

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Find the Source Location of Items

After you add an item to a presentation, you can easily locate the source item in the case. This
can help, for example, if you want to update an exhibitafter you have added it. Or it can also
help if you want to create a new media clip from a media item you already added to a
presentation.

To locate item sources

1. Click the Presentation navigation bar, and then select the presentation that you want to
work with.



Using Sanction 173

© 2019 LexisNexis. All rights reserved.

 

2. In the item list of the presentation, right-click the item that you want to find the source
location for, and then click Find Source Location.

Select the item > right-click > Find Source Location

Sanction opens the folder for the item with the item highlighted.

Related Topics

Annotating in Real Time

Add or Replace Exhibit Pages

Media Clips

Displaying Multiple Item Windows

Manage Presentations

Change Item Presentation Order

By default, the order in which individual items are added to a presentation determines the
order in which they are presented. However, after items are added, you can change their order
of presentation. 

The current presentation order can be determined by looking at the position of items in the
item list for the presentation. The top item will be presented first, with all others following. For
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example, in the following screen capture, when the Example Items presentation is started,
Form will be the first item in queue, followed by Brochure, and then Letter.

To change item presentation sequence

1. Click the Presentations navigation bar.

2. Select the presentation you want to change the sequence of item presentation. 

3. Select items you want to change the presentation sequence for and then do one of the
following:

On the HOME tab, in the Actions group, click Move Up or Move Down, depending on
where you want to place items. 

Right-click and then click Move Up or Move Down, depending on where you want to
place the items. 

The selected items are removed from the presentation. 

     

Related Topics

Annotating in Real Time

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Set Options

There are many options in the presentation window that you can set to suit your needs as a
presenter. The options that you select will apply to all presentations across all cases and will
remain in effect until you change them. 

The rest of this topic lists the presentation options that you can configure, as well as the
procedures for configuring them from the FILE tab or from the presentation window.
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Presentation options available in the Sanction Options dialog box from the presentation w indow or from

FILE tab > Options > Presentations

Presentation window settings

Setting Available
Options

Description

Shown On Primary

Display2

If set to Primary, presentations open on the primary
monitor. Otherwise, presentations open on a second
display, such as a connected second monitor or projection
device.

Show Border No border

Show
borders

Show
borders on
Selected

Controls whether a border appears around individual
display panels in the presentation window. A border can
help to improve the visibility of some items.

Search By Name

Exhibit
number

Trial exhibit
number

Determines the item property for blind typing. The default
property is Name.
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Bates
number

Show Search
Text Box

Enabled or
unchecked

If enabled, the search bar is always visible in the
presentation task bar. Otherwise it is only visible when
searching. 

Load first
item

Enabled or
unchecked

If enabled, when you launch a presentation, the first item
in the presentation is shown automatically. Otherwise the
presentation opens with a black screen. 

Autohide the
Task Bar
when not in
use.

Enabled or
unchecked

If enabled, the presentation task bar slides out of view
during the presentation and slides into view when you
move the mouse to the bottom of the presentation
window. If unchecked, the presentation task bar remains
visible.

Show Item
Name on Task
Bar

Enabled or
unchecked

If enabled, shows the item name on the presentation
taskbar. Otherwise, the item names do not appear.

Start media
playback
immediately
when a media
item is
selected.

Enabled or
unchecked

If enabled, when a media item is selected it starts playing
immediately. Otherwise the media does not start until you
click the play button or press Ctrl+P.

Synchronized
Text

Synchronized
Text

Synchronized
Text As
Overlay

Hide
Synchronized
Text

If set to Synchronized Text, synchronized transcript text
scrolls below the player window. Options for this include:

Number of lines: 1 -10. This is the number of lines of
text that appear onscreen.

Synchronized line: 1 - 3. This is the line number that is in
sync with the video.

Lines to highlight: 1 - 3. The number of lines that are
highlighted.

Font, font size, color. Font settings of the synchronized
text.

Background- and highlight color. Color of the text
background and of the highlight.

If set to Synchronized Text As Overlay, synchronized
transcript text appears as overlay on the lower part of the
video window. Options for this include: 

Font, font size, and color of overlaid text.

Background color and opacity. 

If set to Hide Synchronized Text, synchronized text does
not appear onscreen.

For information on setting transcript font, font size, and font color in the presentation
window and in the main program window, see: Set Transcript Viewer Options.
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To access the presentation settings

You can configure presentation settings from the main window or from within the
presentation window.

To
configure
options
from this
window:

Follow these steps:

Main
program
window

1. On the FILE tab, click Options.

The Sanction Options dialog box opens.

2. Select Presentations. 

3. Configure options as needed and then click OK. 

Presentation
window

1. In the presentation window, click  the presentation options
icon. 

The Sanction Options dialog box opens.

2. Configure presentation options as needed and then click OK.  

Related Topics

Presenting on a Second Display

Displaying Multiple Item Windows

Annotating in Real Time

Media Playback

Run Presentations

Annotate in Real Time

While running a presentation, you can annotate exhibits from the main program window if
Sanction is set to run on 2 displays.  Alternatively, you can annotate by using annotation tools
available in the presentation window. 

For information on Annotation Tools, see: Annotation Tools.

To apply annotations from the main program window

1. Set the presentation to open on Display 2, add an exhibit to a presentation, and show
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the exhibit in the presentation.

For information on using a second display see: Presenting on a Second Display.

For information on adding items to a presentation, see: Add and Remove Items. 

For information on showing an exhibit in a presentation, see: Using the Show Item
Command. See also: Controlling Item Presentation.

2. In the main program window, on the HOME tab, click the Exhibits navigation bar. 

3. Click the exhibit page that is currently being presented. 

4. On the IMAGE TOOLS tab, select an annotation tool and apply your annotation.  For more
information, see: Annotation Tools.

As you apply annotations, they are reflected in real time in the presentation window.

You can setup annotations ahead of time and then have them appear on cue in the
presentation window by using annotation layers. For more information, see: Annotation
Layers.

To apply annotations from within the presentation window

1. Open the exhibit you want to annotate in the presentation window. 

2. In the item presentation window, click the annotation tool icon.

The annotation tools gallery opens. 
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Annotation tools gallery in the presentation w indow 

3. Select an annotation tool and then apply it to the exhibit window as needed. 

For descriptions of available annotation tools, including how to set certain defaults, see: 
Annotation Tools. 

To add annotation layers from the presentation window

You can apply your annotations in layers in the main program window or in the presentation
window. This procedure describes how to add annotations in layers while working in the
presentation window. For information on working with annotation layers while working in
the main program window, see: Annotation Layers.

1. In the presentation window, open the exhibit you want to work with. 

When you click the exhibit, Layer 1 is active by default.

2. Add annotations that you want to appear automatically each time the exhibit is opened. 

During a presentation, when you first open an exhibit, Layer 1 is selected and visible. All
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other layers are hidden. 

3. In the item window, click the tools icon.

4. Select Layers.

 

By default, Layer 1 is selected and visible

5. Select the radio button to the left of 2. 

The Layers tool box closes. Layer 2 is visible and active in the presentation window. Any
annotations added now are applied to Layer 2.

6. Add annotations to Layer 2 as needed. 

7. If you want to add more layers, click the tools icon again. Then repeat the steps to select
an annotation layer and add annotations to it.

To show or hide annotation layers from the presentation window

This procedure assumes that the exhibit you are presenting already has annotations applied
to it on separate layers. 

The presentation window provides keyboard shortcuts to toggle whether layers are
shown or not. For more information, see: Keyboard Shortcuts.

1. In the presentation window, open the exhibit you want to work with.
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2. In the item window, click the tools icon.

3. Select Layers.

 

By default, Layer 1 is selected.

4. Select the icon to the right of the layer number you want to become visible. Note that
Layer 1 cannot be hidden.

The universal no icon  means that the layer is hidden. An eye icon  means that the
layer is currently visible. In the following graphic, layers 1 and 2 are visible. 

Layer 1 is selected, and layer 2 is visible as well as layer 1.
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Related Topics

Setting Presentation Options

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Keyboard Shortcuts

Displaying Items

From within the presentation window, you can select items for presentation in the following
ways:

Move between items in a linear sequence like a slide show.

Pick items from a list. 

Type the item name, exhibit number, trial exhibit number, or Bates number. Using this
method, you can type into a visible search box, or blind type the search. Either way, if the
item that you type was not already included the presentation, it is added to the end of the
presentation. 

To display items in a sequence

In the far right side of the presentation toolbar, click . 

The presentation advances to the next item. 

Note that at the start of the presentation, until the forward button is clicked, the
previous button is inactive. When the last item in the presentation is reached, the
forward button becomes inactive. 

By default, when the presentation window is set to a display mode of Side By Side, 2
Across, or 4 Quadrants, the next item and previous item buttons focus on the most
recently opened item window. However, you can configure the buttons to operate on
whichever item window you want. 

For more information, see: Displaying Multiple Item Windows.

To pick items from a list

1. In the presentation window, click the item selector button.
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2. Select Go to Item.  

3. Select the item you want to display.

4. The item appears in the presentation window.

To display items by typing 

In the presentation window, do either of the following:

Type the item name, exhibit number, trial exhibit number, or Bates number, depending
on which item property the search box is configured to accept and then press Enter.

1. In the presentation window, click the item selector button.

2. Select Show Item.

The search box opens in the presentation tool bar.

 

3. Type the item name, exhibit number, trial exhibit number, or Bates number, depending
on which item property the search box is configured to accept, and then press Enter. 

The item opens in the presentation window. If the item was not already a part of the
current presentation, it is added to the end of the presentation.

If a matching item is not found, a warning icon appears on the presentation task bar,
but the state of the presentation window does not change otherwise.
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To resolve this, here are some things to try:

Check the spelling of the item. 

Check the search properties to determine which field the search box is set to
accept. For example, the search will probably yield an error if the search box is set
to accept the item name and you type a Bates number. To access search box
options, see: Setting Presentation Options.

To configure blind typing

Blind typing is enabled by default. The following procedures tells you how to make sure that
blind typing is enabled and that the search function is set to the item property you want to
search by.

With blind typing, all you do to display an item is type its name, exhibit number, trial exhibit
number, or Bates number, depending on which item property the search is configured to
accept. 

1. To enable blind typing, from the presentation window, click the Presentation Options
button. 

2. In the Sanction Options dialog box, uncheck Show Search Text Box. 

3. Verify whether the property type that is selected in the Search By list is the one that
you want to search by.
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4. Click OK. 

5. In the presentation window, type the item name, exhibit number, trial exhibit number, or
Bates number, depending on which item property the search box is configured to accept.

6. Press Enter.

The matching item is displayed in the presentation window. If the item is not already
part of the presentation, it is added to the end.

If a matching item is not found, a warning icon  appears on the presentation task
bar, and the state of the presentation window does not change.

To resolve this, here are some things to try:

Check the spelling of the item. 

Return to the Sanction Options dialog box and then verify the property type is set to
the one you want to search by. 
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Related Topics

Annotating in Real Time

Using the Show Item Command

Displaying Multiple Item Windows

Display Multiple Item Windows

You can split the presentation window into multiple item windows to simultaneously present up
to 4 different items at a time. The setting that determines this number is called the View Mode.
 

View Modes

You can set the View Mode to: 

Full Screen

Side By Side

3 Across 

4 Quadrants. 

Where can the View Mode be set?

You can change the View Mode either from the main program window (HOME > Presentations >
View Mode button group, which is active only when a presentation is showing. Or you can
change the View Mode from within the presentation window itself. 

View Mode can be set in HOME > Presentations > View Mode button group. 

View Mode can also be set in the Presentation Window
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The View Mode determines the behavior of the presentation window in these ways:

View Mode sets the upward limit to the number of item windows that can open. This term, 
upward limit is used here because the presentation screen always opens in Full Screen. If a
different View Mode (Side By Side, 3 Across, or 4 Quadrant) is selected, the presentation
window only divides into Side By Side, 3 Across, etc., each time you click the next item
button. However, you can override this behavior by unlocking the Display Mode, which is
discussed later in this topic.

As more item windows open, View Mode locks the action of the next and previous item
buttons onto the most-recently opened item window. For example, if you set the View Mode
to 3 Across, once the third item window is opened, the next and previous item buttons only
act upon the third item window. 

It is possible to override this behavior and move between items in a different item window
by unlocking the Display Mode. This is discussed next in this topic.

Overriding the View Mode by unlocking the Display Mode

When the View Mode is set to Side By Side, 3 Across, or 4 Quadrants, you can temporarily
suspend new item windows from opening before you have reached the maximum allowed for
that View Mode setting. You can also page through items in whichever item window is open,
not just the most recently opened item window.

The setting you use to make these changes during your presentation is called the Display
Mode. 

How the Display Mode works

The Display Mode can be set to locked or unlocked. By default, it is set to locked. Unlocking the
Display Mode has the immediate effect of preventing new item windows from opening.
Unlocking the Display Mode also allows you to change the focus of the next and previous item
buttons, so that clicking these buttons will effect whichever item window you select. 

Where can the Display Mode be set?

Like the View Mode, you can control the Display Mode either from the main program window
(HOME > Presentations > Display Mode button group) or from within the presentation window
itself.

To split the screen from the main program window

1. Open the presentation on a second display.

2. In the main program window, on the HOME tab, click the Presentations navigation bar.



LexisNexis Sanction188

© 2019 LexisNexis. All rights reserved.

In the View Mode button group, by default Full Screen mode is selected. 

3. Click the View Mode that you want your presentation to display.

4. Switch to the presentation window.

5. Click . 

Each time  is clicked, a new item window opens, populated with the next item in the
presentation.

To split the screen from within the presentation window

1. Open your presentation.

2. In the presentation window, click the View Mode button.

3. Click the View Mode that you want your presentation to display.

4. Click . 
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Each time  is clicked, a new item window opens, populated with the next item in the
presentation.

To unlock Display Mode from the main program window

1. Open a presentation on a second display. 

2. In the main program window, on the HOME tab, click the Presentations navigation bar.

In the View Mode button group, by default Full Screen mode is selected. 

The Display Mode is locked

3. Set the View Mode to either Side By Side, 3 Across, or 4 Quadrant.

4. Switch to the presentation window.

5. Click  until you have the number of item windows you want open.

6. Switch to the main program window.

7. Click Display Mode.
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The Display Mode is unlocked

8. Return to the presentation window.

9. Click any item window.

10.  On the presentation toolbar, click the next or previous item button. 

The next or previous item is displayed in the selected item window.

11. Click any other item window.

12.  Click the next or previous item button. 

The next or previous item is displayed in the selected item window.If needed, return to
the main program window and then click Display Mode again to lock it.

To set the Display Mode from the presentation window

1. Open a presentation. 

2. In the presentation window, click the View Mode button.
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3. Click the View Mode that you want your presentation to display.

4. Click  until you have the number of item window open that you want.

Each time  is clicked, a new item window opens, populated with the next item in the
presentation. Note that in the screen capture above, the Display Mode is locked.

5. Click the Display Mode button to unlock the Display Mode.

Display Mode is unlocked

6. Click any item window.

7. Click the next or previous item button. 

The next or previous item, relative to the item window, opens in the selected item window. 

Example: showing 3 items simultaneously

These steps illustrate how to present 3 items simultaneously. The screen captures in the
procedure are provided as examples. 

1. Open a new presentation that has 3 or more items in it. 
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2. In the presentation window, click .

The first item in the presentation opens. 

3. In the presentation window, click the View Mode button.

4. Select 3 Across. 

The maximum number of item windows that can be open at one time will be 3

5. Click .
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The presentation window is now divided into 2 item windows. The newly opened item
window shows the second item in the presentation. 

6. Click  again.

The presentation window is now divided into 3 item windows, the maximum that can be
opened with the 3 Across view mode. This third item window shows the third item in the
presentation. 

Each time you click  again, the next item in the presentation will load in the third item
window. For example, in the screen shot above, if the next item arrow is clicked again,
the timeline image will be replaced by the next item in the presentation. The item
windows showing the synchronized transcript and the letter will not change.

To reassign the next and previous item buttons to a different item window
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1. In the presentation window, set the View Mode to Side By Side, 3 Across, or 4
Quadrants. 

2. Repeatedly click  to open multiple item windows until the maximum number of item
windows is open. 

3. Click the Display Mode button so that it is unlocked.

Display Mode is locked Display mode is unlocked.

4. Select the item window you want to use the next and previous item buttons on.

5. Click  and  to move between items in the selected item window.

If the Display Mode is unlocked, it is possible for the same item in the presentation to
be shown in two different item windows at the same time. 

In this situation, clicking   will effect the window that first opened the shared item.
regardless of which item window is selected.

To suspend the maximum number of item windows that can open

1. Click the Display Mode button so that it is unlocked.

Display Mode is locked Display mode is unlocked.

The maximum number of item windows that may be opened is set to the current number
of item windows open. 

Using book paging

You can flip though the items in your presentation like flipping through the pages of a book.
This can be helpful when presenting the pages of a deposition of other multi-page print
documents.

1. Open the presentation you want to flip through.
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2. Press Ctrl+J.

The first item in the presentation is displayed.

3. Press Ctrl+J.

The presentation window changes to side-by-side view mode. The first item is in the left
ttem window, the second in the right. 

4. Press Ctrl+J.

The presentation continues to flip forward, page by page. 

Related Topics

Annotating in Real Time

Showing Items

Controlling Item Presentation

Displaying Multiple Item Windows

Media Playback

Media playback controls are available within the presentation window when media is loaded.
The controls allow you to start, pause, return to the start, and go to the end of the media. In
addition, you can control the volume or mute the playback.

Media playback controls

While the media is loaded in the presentation window, you can save a video frame in real
time as a video still. Sanction saves the video still as an exhibit. When saved as an exhibit,
the video still can annotated as needed and added to presentations. For more information
on creating video stills, see: Video Stills.

To control playback
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1. With the media, clip, or playlist open in the presentation window. 

2. Control playback using the following options:

To do this: Click these buttons:

Start playback of the current clip.

Skip forward to the next clip. The clip starts
playing.

Skip to the previous clip. The clips starts playing.

Cue to the start of the next clip without starting
playback. The player screen is black.

 then 

Cue to the start of the previous clip without
starting playback. The player screen is black.  then 

Stop playback and return the play head to the
first frame of the current clip.

Skip several seconds forward.

Click and hold:

 Skip several seconds backward.

Click and hold:

If you reach the end of the playlist, playback stops and the playing position returns to
the beginning of the first clip in the playlist. The player screen goes black.

To adjust the volume or to mute audio

1. Select the Volume/Mute button on the media player. 

2. Do either of the following:

To increase or decrease the volume, move the slider.
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To toggle the audio on or off, click the Mute/unmute button.

You can tell if the audio is muted by examining the Mute/unmute button.

Audio is on

Audio is muted

Related Topics

Setting Presentation Options

Annotating in Real Time

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Open and Close

You can open presentations from the main program window or from the presentation window. 
This topic covers basic procedures for opening and closing presentations. 

For information on an alternative way to open presentations, see: Using the Show Item
Command. 

To open a presentation from the main program window

1. Click the Presentations navigation bar.
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2. Select the presentation you want to open.

3. On the HOME tab, in the Present group, click Presentation.

The presentation window opens with the selected presentation ready to start. The
presentation window opens with no item displaying. 

You can configure the presentation window to load the first item when the presentation
is started instead of opening to a blank screen. For more information, see: Setting
Presentation Options. 

4. Click  or press Ctrl+Right Arrow to show the first item. 

To open a presentation from the presentation window

1. On the presentation tool bar, click the presentation selection button.
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2. Select the presentation you want to open. 

To close a presentation
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Do one of the following:

Click the presentation selection button,  located at the left corner of the presentation
taskbar, and then click Exit.

If an image is loaded in the presentation window, then right-click a section of the
presentation window to the left or right of the image and then click Exit.

If media is loaded in the presentation window, then right-click anywhere in the
presentation window and then click Exit.

Press Shift+Esc.

In the presentation window, you can press Esc to cause the presentation window to go
blank. The presentation will remain open in the presentation window but no item will be
showing.

Related Topics

Annotating in Real Time

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Present on a Second Display

If your computer is configured to use the extended desktop feature in Windows, you can show
your presentation on the second display, such as a monitor, flat screen TV, or projector. 

On Windows 7 computers, to extend display to a second monitor, press the Windows logo key
+P, and then click Extend. Another way to access the setting is by opening the Display control
panel in Windows (Start > Control Panel > Display > Connect to a Projector). 

To select between displays

1. Make sure extended desktop is enabled on your computer.

2. Click the VIEW tab.

3. Select either Primary or Display2 from the list.
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When Primary is selected, presentations open in the main monitor. 

When Display2 is selected, presentations open in the second display.  

If Display2 is not listed in, here are some things to try:

Make sure the second monitor is powered on.

Verify the physical connection to the second monitor. 

Check the Windows display setting or video card application setting. The option to
extend the desktop to the second monitor should be enabled. On Windows 7
computers, to extend display to a second monitor, press the Windows logo key+P,
and then click Extend. Another way to access the setting is by opening the Display
control panel in Windows (Start > Control Panel > Display > Connect to a
Projector). 

If you enabled extended desktop after opening the case, try closing the case and
then opening it again.

Related Topics

Annotating in Real Time

Using the Show Item Command

Controlling Item Presentation

Displaying Multiple Item Windows

Use the Show Item Command

You can immediately show in the presentation window any exhibit page, media item, media clip,
playlist, or transcript, even if the item has not been previously added to a presentation and
even if the presentation window is not open. 

To accomplish this, you run the Show Item command.
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HOME > Present > Show Item 

When you run the Show Item command, the following conditions apply:

The presentation that is selected in the presentation list will open. If the presentation
window already has a different presentation showing, the selected presentation will take
its place.

Show Item opens the item in the currently selected presentation

The item you used the Show Item command on will be added to the end of the
presentation. 

If the item you show was already a part of the presentation, a second instance of the item
will be added to the end of the presentation, except when the item is selected from a the
item list of a presentation.

To show an exhibit, media item, or transcript from the main program window

1. Select the item that you want to show. 

2. Do either of the following: 

Press Ctrl+S.

On the HOME tab, in the Present group, click Show Item. 

The item opens in the presentation window. If a presentation is not already open, the
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item opens in the presentation that is selected in the presentation list. 

To show an item selected from a presentation item list

1. Select the Presentations navigation bar.

2. Select the presentation that has the item that you want to show.

3. In the item list for the presentation, select the item you want to show.

4. From the main program window, do either of the following: 

Press Ctrl+S.

On the HOME tab, in the Present group, click Show Item. 

The item opens in the presentation window.

      

Related Topics

Annotating in Real Time

Controlling Item Presentation

Displaying Multiple Item Windows

Reports

Duration List Reports

A duration list report totals the running time of individual clips and playlists that you select.
Optionally, you can create reports that list the clips, playlists, or presentations in your case.
Reports may be formatted in Rich Text Format (RTF) or plain text. 

You can choose from among several fields to include in your report: 

Media Clip Name

Description

Page and Line Range

Transcript Text

Total Duration

Start and End Times

Title
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Duration

Media file Name

To export duration list reports

1. Do one of the following:

On the FILE tab, in the Info area, click Export, and then click Duration List Report.

On the HOME tab, in the Share group, click Export, and then click Duration List Report.

The Duration List Report Export Wizard starts.

2. Click Next.

The Select Media Clips and/or Playlists dialog box opens.

3. In the drop-down list, select Media, Playlists, or Presentations.  

4. Select clips or playlists from the folders positioned in the dialog box below the drop-
down list. 

The clips and playlists that you select are listed in the left panel. Note that if you select a
playlist, all the clips that constitute the playlist are automatically added to the report.

5. To add an individual item listed in the left list panel to the report, select the item and
then click Add Selection. To add all the items in the left list panel, click Add All. 

After adding items, you can remove them as needed from the queue. To remove one or
more items, CTRL+click or SHIFT+click items and then click Remove Selected. To
remove all items, click Remove All.

6. Click Next.

The Select the Destination File dialog box opens.

7. Select either RTF for Rich Text Format or TXT for plain text format. 

8. Click Change.
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The Select the Destination File dialog box opens.

9. Select the folder where you want to save the report, type a file name for the report, and
then click Save.

10. In the Select the Destination File dialog box, review your selections and then click Next.

The Ready To Export dialog box opens.

11. Review your selections. When ready, click Next.

12. In the Export Confirmation dialog box, click Close.

Related Topics

Annotation Tools

Media Clips

Playlists

Keyboard shortcuts

Using keyboard shortcuts

Download a PDF of Sanction 5 Keyboard Shortcuts.

Keyboard Shortcuts - HOME > Exhibits Area

Group > Button Task Shortcut

New > Import Import exhibits, media, transcripts,
exhibit load files, and clip lists.

Ctrl+I

New > New
Folder

Create a new folder. Ctrl+Shift+F3

New > Capture Create a screen capture of the
contents of the exhibit viewer.

F7

Actions > Update
Exhibit

Add pages to an exhibit or update
existing pages. 

Ctrl+U

Actions > Edit
Edit exhibit or page properties,
such as the name, exhibit number,
or Bates number.

Ctrl+Shift+I

Actions > Move Move the selected exhibit. Ctrl+Shift+F2

Actions > Delete Delete the selected exhibit. Ctrl+D

Actions >
Rename Folder

Rename the selected folder. Ctrl+Shift+F

Actions > Move
Folder

Move the selected folder. Ctrl+Shift+M

http://www.lexisnexis.com/Casemapsuitesupport/sanction/sanction_docs/sa5/Sanction5_KBSC_QRC.pdf
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Actions > Delete
Folder

Delete the selected folder. (Folder
must be empty.)

Ctrl+Shift+D

Add To >
Presentation

Add the selected page to the
existing presentation of your
choice. Or create a new
presentation from a selected
page.

Ctrl+Shift A

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected
item in the presentation window.

Ctrl+S

Share > Export Export exhibits, clips, playlists, and
duration list reports. 

Ctrl+Shift+E

Share > Print Print exhibits. Ctrl+Shift+P

Search > Find
Items

Search for items by item
properties, such as name, exhibit
number, trial number, Bates
number, or description.

Search for items by admit date or
transcript date. 

Ctrl+F

Shortcut keys - HOME > Media

Group > Button Task Shortcut

New > Import Import exhibits, media, transcripts,
exhibit load files, and clip lists.

Ctrl+I

New > New
Folder

Create a new folder. Ctrl+Shift+F3

New > Video
Still

Create a video still from a frame of
video.

Ctrl+Shift+V

Actions >
Rename

Rename the selected media or clip. F2

Actions > Edit Edit the properties of the selected
media or clip.

Ctrl+Shift+I

Actions > Move Move the selected media item. Ctrl+Shift+F2

Actions > Delete Delete the selected media or clip. Ctrl+D

Actions >
Rename Folder

Rename the selected folder. Ctrl+Shift+F

Actions > Move
Folder

Move the selected folder. Ctrl+Shift+M

Actions > Delete
Folder

Delete the selected folder. (Folder
must be empty.)

Ctrl+Shift+D

Actions > Move
Up

Move the selected clip up in the
playlist.

Ctrl+Alt+U
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Actions > Move
Down

Move the selected clip down in the
playlist.

Ctrl+Alt+U

Actions >
Remove Item

Remove the selected clip from the
playlist.

Ctrl+Alt+R

Add To >
Presentation

Add the selected media to the
existing presentation of your
choice. Or create a new
presentation from a selected
media.

Ctrl+Shift A

Add To >
Playlist

Add the selected clip to an existing
playlist. Or create a new playlist
from a selected clip.

Ctrl+Y

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected
item in the presentation window.

Ctrl+S

Share > Export Export exhibits, clips, playlists, and
duration list reports. 

Ctrl+Shift+E

Share > Print Print exhibits. Ctrl+Shift+P

Search > Find
Items

Search for items by item
properties, such as name, exhibit
number, trial number, Bates
number, or description.

Search for items by admit date or
transcript date. 

Ctrl+F

Keyboard Shortcuts - HOME > Transcripts

Group > Button Task Shortcut

New > Import Import exhibits, media, transcripts,
exhibit load files, and clip lists.

Ctrl+I

New > Media
Clip

Create a new media clip from
selected lines in  a synchronized
transcript.

Ctrl+Alt+M

New > Text Clip Create an image of the selected
transcript text.

Ctrl+Shift+X

New > Video
Still

Create a new video still from a
frame in a synchronized transcript.

Ctrl+Shift+V

Actions >
Rename

Rename the selected transcript. F2

Actions > Edit Edit transcript properties. Ctrl+Shift+I

Actions > Delete Delete the selected transcript. Ctrl+D

Add To >
Presentation

Add the selected transcript to the
existing presentation of your

Ctrl+Shift A
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choice. Or create a new
presentation from a selected
transcript.

Add To >
Playlist

Add selected clip (from a
synchronized transcript) to an
existing transcript, or create a new
transcript from the selected clip. 

Ctrl+Y

Present >
Presentation

Open the presentation window. Ctrl+Shift+F1

Present > Show
Item

Immediately open the selected
transcript in the presentation
window.

Ctrl+S

Share > Export Export exhibits, clips, playlists, and
duration list reports. 

Ctrl+Shift+E

Search > Find
Items

Search for items by item
properties, such as name, exhibit
number, trial number, Bates
number, or description.

Search for items by admit date or
transcript date. 

Ctrl+F

Keyboard Shortcuts - HOME > Presentations

Group > Button Task Shortcut

New > Import
Import exhibits, media,
transcripts, exhibit load files,
and clip lists.

Ctrl+I

New > New
Presentation

Create a new presentation. Ctrl+Shift+N

Actions >
Rename

Rename selected
presentation. 

F2

Actions > Delete Delete selected
presentation. 

Ctrl+D

Actions > Move
Up

Move selected items up in
the presentation.

Ctrl+Alt+U

Actions > Move
Down

Move selected items down in
the presentation. 

Ctrl+Alt+D

Actions >
Remove Item

Remove selected items from
the presentation. 

Ctrl+Alt+R

Add To >
Presentation

Add the currently selected
item to a different
presentation, or create a
new presentation from a
selected item.

Ctrl+Shift+A

Present >
Presentation

Open the selected
presentation.

Ctrl+Shift+F1
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Present > Show
Item

Open the selected item in
the presentation window.

Ctrl+S

Share > Export
Export exhibits, clips,
playlists, and duration list
reports.

Ctrl+Shift+E

Display Mode

Only active when
presentation window is
open.

Allows you to change the
focus of the next item
button and previous item
button to different item
windows when View Mode
is set to Side By Side, 3
Across, or 4 Quadrants.

Prevents new item
windows from opening
when View Mode is set to
Side By Side, 3 Across, or 4
Quadrant.

Display Mode
(locked)              

Display Mode
(unlocked)

Ctrl+Shift+T (Toggles on/off)

View Mode

Sets a maximum to the
number of item windows
that can be opened at one
time in the presentation
window. 

Only active when
presentation window is
open.

Regardless of which View
Mode is selected, when you
open a presentation, the
window opens as a Full
Screen.

Full Screen: Ctrl+Shift+Up Arrow

Side By Side: Ctrl+Shift+Left Arrow

3 Across: Ctrl+Shift+Right Arrow

4 Quadrants: Ctrl+Shift+Down Arrow

Keyboard Shortcuts - Presentation window
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Action Key combination

Full Screen view mode F11 

or

Alt+Shift+Up Arrow

Side by Side view mode Alt+Shift+Left Arrow 

3 Across view mode Alt+Shift+Right Arrow

4 Quadrant View  Alt+Shift+Down Arrow 

Rotate image counterclockwise Ctrl+Comma 

Rotate image clockwise Ctrl+Period 

Select Ctrl+Shift+S 

Crop/Zoom Ctrl+M 

Tear out (in presentation window) Ctrl+O 

Pan In the presentation window, there
is no shortcut key for the Pan tool.

In the main program window, Ctrl
+Alt+P activates the Pan tool.

Erase Ctrl+D in the presentation window.

In the main program window, Ctrl
+Alt+S activates Erase tool.

Delete all visible annotations Ctrl+Delete 

In presentation window, this
shortcut deletes all visible
annotations.

In main program window, this
shortcut activates the Delete
Annotations menu item.

Highlight Ctrl+H

Arrow Ctrl+W 

Line Ctrl+L

Pen Ctrl+N 
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Rectangle Ctrl+G

Ellipse Ctrl+E 

Redaction Ctrl+Shift+R 

Play\Pause media Ctrl+P 

Go to page

(when multiple pages from the same exhibit
have been added to a presentation) 

1. Press CTRL 

2. Press \ 

3. Type the page number 

4. Press ENTER 

Show previous item Ctrl+Left Arrow

Show next item Ctrl+Right Arrow

Close all other item windows Ctrl+Shift+F4 

Display Mode lock/unlock Ctrl+Shift+T 

Zoom in/out exhibit page (using mouse) Ctrl+Mouse wheel forward or back 

Zoom in exhibit page (using keyboard) Ctrl+Plus

or 

Ctrl+Equals

Zoom out exhibit page (using keyboard) Ctrl+Minus

Next presentation 

Previous presentation

Ctrl+Alt+P 

Shift+Alt+P

Clear presentation window Esc

Close presentation window Shift+Esc 

Close all item windows Shift+F4 

Select next item window Tab

Select previous item window Shift+Tab 

Layer visibility Ctrl+[Layer#] (e.g. 2 - 9) to toggle
on/off

Show next hidden layer 

Hide last visible layer

F12 

Shift+F12
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(not available in main program
window)

Capture F7 

Page up and page down through a multi-page
exhibit

Page Up

Page Down 

Page forward like a book Ctrl+J

Keyboard Shortcuts - VIEW tab

Group > Button Task Shortcut

Layout > Details View
Change the details view of
exhibits to left, minimized, or
right.

Ctrl+Alt+V 

Layout > Details View
Show or minimize navigation
panes. 

Ctrl+Alt+N

Monitors
Show presentations on a second
display, such as an external
monitor or projector. 

Ctrl+Alt+Y 

Keyboard Shortcuts - IMAGE TOOLS tab

Group > Button Task Shortcut

Tools > Select Selection tool. Ctrl+Shift+S

Tools > Crop Crop and zoom. Ctrl+M

Tools > Tear Out Magnify a selected part of the page and
move the selection around.

Ctrl+O

Tools > Magnifier Drag a magnifier across the exhibit. Ctrl+Alt+G

Tools > Pan Drag a zoomed page around in the exhibit
viewer window.

Ctrl+Alt+P

Tools > Erase

Erase annotations one at a time.

Note -- in the presentation window, the
shortcut key for Erase is Ctrl+D .

Ctrl+Alt+S

Tools > Delete
Annotations

Delete all of the annotations or exhibit
stamps applied to selected exhibit pages.

IMPORTANT

In presentation window, Ctrl+Delete

Ctrl+Delete
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immediately deletes all visible
annotations.

Annotations > Highlight Create a transparent rectangle. Ctrl+H

Annotations > Arrow Draw an arrow. Ctrl+W

Annotations > Line Draw a line. Ctrl+L

Annotations > Pen Draw a freehand shape. Ctrl+N

Annotations > Rectangle Create an unfilled ellipse. Ctrl+G

Annotations > Ellipse Create an unfilled rectangle. Ctrl+E

Annotations > Redaction Create a filled rectangle. Ctrl+R

Annotations > Text Type text into the exhibit. Ctrl+Alt+X

Options > Line Size Set the line thickness for: arrow, line, pen,
rectangle, and ellipse.

Ctrl+Alt+I

Options > Line Color Set the line color for: arrow, line, pen,
rectangle, and ellipse.

CTRL+Alt+O

Options > Fill Color Set the fill color for: highlight, redaction,
and text box.

Ctrl+Alt+F

Layers > 1 - 9

Select a layer; show it if it is hidden.

For more information, see: Annotation
Layers.

Ctrl+[Layer#] 

(e.g. 2 - 9)

Image > Rotate Right Rotate page right. Ctrl+Period

Image > Rotate Left Rotate page left. Ctrl+Comma

Image > Print Print the selected exhibit page. Ctrl+Shift+P

Related Topics

Quick Start Guide

Customizing the Layout
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Index
- A -
adding    

exhibit pages     79

annotation layers    

in main program window     85

in presentation window     177

annotations    

creating during presentations     177

deleting all     80

highlighting     80

layers     80

redactions     80

tools     80

- B -
Bates numbering    

multiple exhibits (wizard)     105

blind typing     182

buttons     15, 17, 20, 23, 26, 29, 30, 31

- C -
case    

practice case     38

cases    

creating     37

openning     37

pinning to recent cases     37

Clip Creator     15, 17, 20, 23, 26, 29, 30, 31, 116

clip lists    

creating     156

importing     156

creating    

cases     37

folders     44

media clips     116

playlists (multiclips)     121

preferred media paths     130

presentations     167

screen captures     94

tear outs     96

text clips     100, 159

video stills     102, 135

- D -
defaults     80

deleting    

folders     44

items     41

presentations     167

display to a projector or monitor     200

drag and drop import    

exhibits     47

media     64, 110

duplicates    

importing     45

- E -
editing item properties     42

exhibit pages    

add or replace     79

Exhibit stamps     87

delete all     89

exhibits    

Bates numbering a single exhibit     42

Bates numbering multiple via wizard     105

file formats     45

importing     47

page view controls     109

printing     90

renaming a single exhibit     42

renaming multiple via wizard     105

renumbering a single exhibit     42

renumbering multiple via wizard     105

rotate     92

saving as new page     93

screen captures     94

stamps     87

text clips     100

video stills     102, 135

Exhibits navigation bar     15, 17, 20, 23, 26, 29, 30,
31

extended desktop     200
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- F -
FILE tab     15, 17, 20, 23, 26, 29, 30, 31

folders    

deleting     41

user     44

- H -
HOME tab     15, 17, 20, 23, 26, 29, 30, 31

hotkeys     205

How-to training videos     15

- I -
IMAGE TOOLS tab     15, 17, 20, 23, 26, 29, 30, 31

images    

rotate     92

importing    

clip lists     156

exhibits     47

how duplicates are handled     45

media     64, 110

overview     45

supported file formats     45

transcripts     69, 140

IPro .LFP files     47

item properties    

main article     42

item types     39

items    

deleting     41

searching     162

- K -
keyboard shortcuts     205

- L -
layers    

exhibit stamps on Layer 1     87

load files for exhibits     47

- M -
media    

adding to playlists     121

copying video to the Media folder     134

file formats     45

importing     64, 110

media clips     116

mute during presentations     195

preferred media paths     130

set volume during presentations     195

media clips    

adding to playlists     116, 121

adding to presentations     116

creating     116

deleting     41

from synchronized transcripts     143

Media File Not Found message     130

Media navigation bar     15, 17, 20, 23, 26, 29, 30, 31

media paths     130

menu items     15, 17, 20, 23, 26, 29, 30, 31

multiclips -- see playlists     121

multiple displays     200

mute media     195

- N -
navigating     15, 17, 20, 23, 26, 29, 30, 31

navigation bars     15, 17, 20, 23, 26, 29, 30, 31

- O -
Opticon .LOG files     47

- P -
pages    

rotate     92

playlists    

adding a media clip to     116

adding one to a presentation     121

creating     121

deleting     41, 121

editing     121

preferred media paths     130

presentation window     15, 17, 20, 23, 26, 29, 30, 31
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presentation window     15, 17, 20, 23, 26, 29, 30, 31

searching transcript text     166

presentations    

adding a media clip to     116

adding items     170

adding playlists     121

adjust volume     195

annotation tools     177

blind typing     182

changing item sequence     173

closing     197

creating     167

deleting     167

display selection     200

finding item sources     172

layout     186

media playback     195

monitors     200

multiple item windows     186

mute     195

Next and Previous Item buttons     186

opening     197

paging between items     182

removing items     170

renaming     167

selecting items from a list     182

setting defaults     174

showing items     201

unmute     195

Presentations navigation bar     15, 17, 20, 23, 26, 29,
30, 31

printing    

exhibits     90

- Q -
Quick Clips     116

- R -
recent cases    

pinning     37

redactions     80

renaming    

folders     44

items     42

multiple exhibits (wizard)     105

presentations     167

renumbering    

multiple exhibits (wizard)     105

replacing    

exhibit pages     79

reports    

Duration List Report     203

- S -
sample case     38

Sanction    

navigating     15, 17, 20, 23, 26, 29, 30, 31

practice case     38

user interface     15, 17, 20, 23, 26, 29, 30, 31

saving    

cases     37

screen captures    

how to create     94

where stored     94

search    

by item date     162

by item properties     162

for case items     162

for transcript text     166

Show Item command     201

synchronized transcripts    

main article     143

Media File Not Found     130

using clip lists to create clips     156

- T -
tabs     15, 17, 20, 23, 26, 29, 30, 31

tear out tool    

how to use     96

on annotation toolbar     80

setting the default     96

text clips    

from synchronized transcripts     143

how to create     100

main article     159

where stored     100

transcripts    

creating text clips from     100

file formats     45

importing     69, 140
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transcripts    

searching the text of     166

viewer options     161

Transcripts navigation bar     15, 17, 20, 23, 26, 29,
30, 31

- U -
user folders     44

user interface guide     15, 17, 20, 23, 26, 29, 30, 31

- V -
video    

copying to the Media folder     134

video stills    

from synchronized transcripts     143

how to create     102, 135

where stored     102, 135

VIEW tab     15, 17, 20, 23, 26, 29, 30, 31

- W -
what's new     6

window layout     11

wizards    

Bates numbering     105

renaming     105

renumbering     105
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